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Introduction
This Release Notes document summarizes the features, enhancements, and updates delivered with 
FlexNet Operations 2025 R2 in April 2026. The document includes the following information:

• Resources

• Features and Enhancements

• System Requirements

• Resolved Issues

• Known Issues

• Special Notes

• SOAP API Change Log

• Legal Information

Resources
These resources are available for more information about FlexNet Operations and other Revenera 
products:

• Revenera Resources

• FlexNet Operations Videos

Revenera Resources
The following resources can help you stay up to date with FlexNet Operations news and product 
knowledge:

• In addition to providing case management, the Revenera Community site can help you quickly find 
answers to your questions by searching content from other customers, product experts, and 
thought leaders. You can also post questions on discussion forums for experts to answer. For 
each of Revenera’s product solutions, you can access forums, blog posts, and knowledge base 
articles. You can also access the Product and License Center from the Community’s Other 
Resources menu to download Revenera products.

• You can find documentation for FlexNet Operations and all other Revenera products on the 
Revenera Product Documentation site.

Note that any FlexNet Operations documentation published for UAT is subject to finalization until 
the Production release.

• The Revenera Learning Center offers free, self-guided, online videos to help you quickly get the 
most out of your Revenera products. You can find a complete list of these training videos in the 
Learning Center. 

• Customers who have purchased a maintenance contract for their product(s) can submit a support 
case or check the status of an existing case by first logging into the Revenera Community, clicking 

https://community.revenera.com
https://docs.revenera.com
https://learning.revenera.com
https://community.revenera.com
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Support on the navigation menu to open the Support Hub page, and then clicking the Open New 
Case or Case Portal button.

FlexNet Operations Videos
These brief, informative videos walk you through the getting-started exercises found in the FlexNet 
Operations User Guide (online help or PDF version). We recommend that you first read the appropriate 
“Getting Started” section in the User Guide to gain an understanding of the concepts it covers, and 
then click the section title in the table below to view the video.  

Features and Enhancements
Features and enhancements were added to the following areas of FlexNet Operations in the 2025 R2 
release:

• Account and User Management Enhancements

• Device Management Enhancements

• Entitlement Management Enhancements

Guide Topics

Getting Started with 
Entitlement Management

Creating an account, a user, a product, and an entitlement. 

Getting Started with FlexNet 
Embedded Licensing

Setting up a publisher, identity, and a licensed product. Creating a 
device and activating its license. Creating and provisioning FlexNet 
Embedded license servers. 

Getting Started with 
Electronic Software Delivery

Creating a producer and download packages, associating 
download packages with a product, creating files, associating files 
with download packages, and viewing and downloading files from 
the FlexNet Operations End-User Portal. 

Getting Started with Usage 
Management

Creating a usage-based license model, a feature, a product, and an 
entitlement. Obtaining the license server URL to which the usage 
data is sent. Running a usage-capture client. Viewing usage 
information graphs and gauges.

Getting Started with FlexNet 
Publisher License File-Based 
Licensing

Activating and returning a certificate license.

Getting Started with Cloud 
Licensing Service

Creating a cloud-hosted license server. 

Getting Started with FlexNet 
Customer Growth

Customer growth concepts and configuring notifications for 
expiring entitlements and expired entitlements. 

https://youtu.be/L_DJynsiCRs
https://youtu.be/6-juN9F9OBo
https://www.youtube.com/watch?v=VGnH8dFj_bE
https://youtu.be/1rPRl-NKgJY
https://youtu.be/-OHqqD62fyk
https://www.youtube.com/watch?v=MNX5bgFHPVg
https://youtu.be/u0oCCN-iXJU
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• Export and Import Enhancements

• Security Enhancements

• SOAP and REST Web Services Enhancements

• User Experience Enhancements

Account and User Management Enhancements
The following enhancements for the management of accounts and users were added.

• Support for Country Field in FlexNet Operations’ User Synchronization Service

• Assigning Account When Processing Capability Requests Without User-Related Information

Support for Country Field in FlexNet Operations’ User Synchronization 
Service 
(Case 04164122, SWM-29615)

FlexNet Operations now supports capturing the user's country information during SCIM-based user 
provisioning.

Previously, all users created via FlexNet Operations’ user synchronization functionality (see Automated 
User Provisioning from Identity Providers (IdPs) to FlexNet Operations for more information) were 
assigned a default country code of US. The country code for users based in countries other than the US 
had to be updated manually to reflect the correct country.  

Now, a user’s country information (if available) is passed from the Identity Provider (IdP) during user 
synchronization and stored directly in the user profile. This enhancement reduces manual effort 
required to update user profiles and helps ensure accurate country data for compliance checks, 
including Electronic Software Delivery (ESD) validations.

Implementation Notes

The country value must be provided in ISO 3166-1 Alpha-2 format (for example, IN for India, GB for 
United Kingdom).

If the country code is invalid or not in the correct format, the system will return an error and the user 
will not be created in FlexNet Operations. 

If the country code is missing, the user will still be created in FlexNet Operations, but will be assigned 
a default country code of US. No error message will be displayed in this case.

Customers who need assistance updating their Identity Provide (IdP) configuration to include the 
country code attribute in their user data for FlexNet Operations‘ User Synchronization Service should 
contact Revenera Support. 

Assigning Account When Processing Capability Requests Without User-
Related Information
(SWM-23219)

https://docs.revenera.com/fno_CURRENT/producer/Content/helplibrary/opsIdPSyncIntro.htm
https://docs.revenera.com/fno_CURRENT/producer/Content/helplibrary/opsIdPSyncIntro.htm
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When a capability request that does not include an enterprise ID or activation ID is uploaded to the 
End-User Portal, FlexNet Operations creates the corresponding device. However, the device does not 
appear on the End-User Portal’s Devices page, because it is created without an associated account.

This release introduces an enhancement that changes this behavior: When a capability request is 
uploaded via the End-User Portal, the device can now be automatically assigned to the account of the 
logged-in user, ensuring it is visible on the Devices page. 

Behavior Details

The following happens when uploading a capability request without user-related information in the 
End-User Portal (under Devices > Offline License Management):

• If the logged-in user is associated with a single account, a dropdown menu is displayed with that 
account pre-selected. 

Figure 1: The new Account ID dropdown menu shows the account that the user will be associated 
with. 

• If the logged-in user is associated with multiple accounts, the dropdown menu lists all associated 
accounts. The user can then select the appropriate account to associate with the device.
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Figure 2: Using the Account ID dropdown menu, the user can select the account to be associated 
with the device.

Enabling New Behavior

This enhancement is controlled by a release flag and is disabled by default. Producers can enable the 
new behavior by setting the following flag: 

autoAssignLoggedUserToOfflineDeviceConfig.enabled

Note • When the configuration option Allow Server Without Activation IDs is enabled, FlexNet 
Operations can process capability requests generated by a FlexNet Embedded local license server that 
do not include an activation ID. 

Device Management Enhancements
The following enhancements to device management were added.

• Devices Template Enhancements

• Obsolete Device and Server Actions in End-User Portal

• New Job “Obsolete Inactive Devices”

• Device Event Notifications to Include CLS Instance

• Enhanced Visibility into Cloud Licensing Service Instance Details and Features
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Devices Template Enhancements 
(Cases 02880447, 02880444; SWM-21905, SWM-27074, SWM-27230, SWM-26157)

In this release, the Devices Import template has been enhanced to help producers manage devices at 
scale. See the following sections for details: 

• Creating Devices

• Updating Device Attributes

• Returning Devices

• Adding Site Name

• Using the Devices Template

Creating Devices

The new CreateHost worksheet streamlines the creation of devices and servers via Excel import, 
eliminating the need for manual entry — which is often time-consuming and error-prone.

You can specify the following details on the CreateHost worksheet:

• Host ID

• Host alias

• Identity

• Publisher name

• Host class

• Server deployment type

• Host ID type

• Host model

• Account ID

• Site name

• Notes

• User ID

• Backup server ID

Updating Device Attributes

The new sheet called UpdateHost has been added to the template, enabling bulk updates to the 
following device attributes: site name, notes, user ID, backup server ID, and device display name.

In the template, the following properties must be provided to update device attributes: host ID, host 
alias, publisher name, host class, and host ID type. 

This screenshot shows an example of a populated template:
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Figure 3: Example of a populated UpdateHost sheet.

Returning Devices

The new ReturnHost worksheet enables users to return (de-register) multiple devices in a single 
operation. This approach significantly reduces execution time for bulk device returns.

You can specify the following details on the ReturnHost worksheet:

• Transaction Type

• Host ID

• Publisher Name

• Host Class

• Host ID Type

• Target Host ID

• Target Host Publisher Name

• Target Host Class 

• Target Host ID Type

• Return Material Authorization Number

Adding Site Name

A new optional column, SiteName, has been added to the AssignAccountToHost sheet of the Devices 
Template. While this column cannot be used as input for this operation, it helps producers more 
effectively differentiate between devices and servers based on their site name.

Figure 4: Example of a populated SiteName column on the AssignAccountToHost sheet of the Devices 
Template.
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Using the Devices Template

Producers would perform the following steps to to create, update, or return devices in bulk using the 
updated template:

1. Navigate to Administer > Import Data Objects and select the Data Import Templates tab.

2. Click the hyperlinked name of the Devices Template to download it.

Figure 5: The Devices Template can be downloaded from the Import Data Objects page.

3. Open DevicesTemplate.xlsx and locate the desired sheet. For example, to create multiple 
devices, select the CreateHost sheet. Provide relevant details for each device or server. 

Note • In the template, column headers formatted in bold indicate mandatory fields.

4. Save the populated spreadsheet as a Unicode .txt file.

5. Return to the Import Settings tab on the Import Data Objects page and upload the .txt file to 
import the new entities (see also Importing Entities in the FlexNet Operations User Guide).

This screenshot shows an example of a populated template:

Obsolete Device and Server Actions in End-User Portal
(Case 03906962, SWM-29036, SWM-30696)

We’ve added new functionality to the End-User Portal, enabling end users to manage devices—
standalone devices, local license servers and Cloud License Servers—more effectively:

https://docs.revenera.com/fno2025r2_onprem/producer/Content/helplibrary/Importing_Entities.htm
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• The Device, View Server and Cloud License Server Details pages now include the Obsolete Device 
and Obsolete Server options in the Action menu.

• These actions provide functionality equivalent to the existing Make Obsolete feature in the 
Producer Portal.

Configuration & Permissions

The new options can be hidden by deselecting the system configuration option Allow Obsolete 
Devices/Servers (under System > Configure > End-User Portal Setup > Devices Page). By default, the 
configuration option is selected.

Only users with the permission Obsolete Devices/Servers (part of the Account Permissions - End-User 
Portal group) can view and use these actions. This permission is assigned by default only to system 
administrator users.

New Job “Obsolete Inactive Devices”
(SWM-27146) 

The 2025 R2 release introduces a new job, Obsolete Inactive Devices. This job enables producers to 
mark any devices as Obsolete that have not been updated within a specified period of inactivity. This 
feature is particularly useful for generating accurate analytics reports that reflect only active devices.

Devices are evaluated based on their Last Modified date. Any device that exceeds a configured 
inactivity threshold will be updated to an Obsolete status. 

The inactivity threshold is defined using the new configuration option Device inactivity period (under 
System > Configure > FlexNet Operations > Embedded Device Settings). 

The value must include a number followed by a time unit:

• D = Days

• W = Weeks

• M = Months

• Y = Years

Examples for Configuration Values 
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• 2Y—Devices not modified in the last 2 years will be marked obsolete.

• 20W—Devices inactive for 20 weeks will be marked obsolete.

Setting up the Obsolete Inactive Devices Job

You can access the Obsolete Inactive Devices job on the Configure Alerts/Jobs page (available by 
clicking Administer > Configure Alerts/Jobs). 

To activate the job:

• On the Configure Alerts/Jobs page, change its status to Active. 

• Set the configuration option Device inactivity period to the desired value.

Important Notes for the Obsolete Inactive Devices Job

Marking a device as Obsolete is a permanent action and cannot be undone. Use this job with caution, 
especially in production environments. To help prevent accidental obsolescence, the following 
safeguards are in place:

• The Obsolete Inactive Devices job is disabled by default. 

• The default device inactivity period is set to 100 years (100Y).

Device Event Notifications to Include CLS Instance
(Case 03008370, FNE-22963) 

Previously, when a device notification was triggered for a feature update, the notification included the 
relevant device ID and the state of the license update. However, it did not include information about 
the Cloud Licensing Service (CLS) instance where the update occurred. This made it difficult for 
producers to selectively update any middleware (for example, their own licensing database) with the 
relevant licensing information. 

Starting with the 2025 R2 release, producers can now receive real-time notifications that include the 
Cloud Licensing Service (CLS) instance ID whenever a CLS instance is updated (e.g., license or 
configuration changes). This enables producers to then trigger targeted /features requests to only 
those CLS instances, without increasing the load on other instances.

Implementation Details 

A device event notification is generated for any update on a CLS instance. This includes license 
changes, configuration updates, or metadata modifications.

Each notification payload includes the unique device ID of the updated CLS instance.

Activating CLS Device Event Notifications 

To receive device event notifications from a CLS instance, update the CLS configuration using the 
following API call: 

PUT https://<siteID>-uat.compliance.flexnetoperations.com/api/1.0/instances/<CLS-
instanceID>/configuration

For production environments, omit “-uat”.

Payload
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In the payload, specify true to receive CLS device event notifications, or false to deactivate CLS device 
event notifications.

{
"licensing.enableChangeNotification":"true"

}

Sample Payload for a Cloud Licensing Service Device Event Notification

The following shows a sample payload that would be delivered to a webhook endpoint when a certain 
event occurs on a Cloud Licensing Service instance.

{
"eventHeader": {

"event": "CLS_INSTANCE",
"eventType": "UPDATE",
"userId": "producer",
"tenant": "ADMN",
"timeStamp": "1752645569000"

},
"eventBody": {

"deviceName": "H6WF4YMBFGGK",
"deviceId": "H6WF4YMBFGGK",
"version": "4",
"id": "434485",
"siteName": null,
"owner": null,
"identity": null,
"deploymentType": "CLOUD",
"hostType": null,
"status": "License Updated",
"active": "Active",
"notes": null,
"errorMessage": null,
"idtype": null,
"lastUpdated": "1752645569000",
"ownerName": null,
"addOnInfoList": null

}
}

Enhanced Visibility into Cloud Licensing Service Instance Details and 
Features 
The Producer Portal and End-User Portal now feature an upgraded interface that provides extended 
visibility into Cloud Licensing Service (CLS) instances.

The new built-in, intuitive user interface offers a clearer view of features, licenses and devices, which 
simplifies license operations for both producers and customers. 

As an out-of-the-box solution, the interface eliminates the need for producers to develop custom UIs—
reducing overhead, accelerating time-to-value, and helping customers better understand entitlement 
purchases and usage.
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Key Enhancements

• Producer Portal and End-User Portal users can now view Cloud License Server information 
equivalent to that available for Local License Servers in the FlexNet License Server Manager.

• Clicking a Cloud License Server device name on the Devices page opens a redesigned page with a 
tabbed layout.

Tabbed Interface Breakdown

This release introduces the following new tabs. Click on the relevant link to jump to the section: 

• Overview Tab 

• Features Tab

• Active Clients

• Named License Pools

Note • The pages to display device information for standalone devices, served devices and local 
license servers remain unchanged. 

Overview Tab

The Overview tab displays the same server information previously shown on the View Server page. 
This tab is selected by default.

Figure 6: Example of the Overview tab with information for a Cloud License Server.

Note • No changes have been made to the commands available from the View, Edit, and Licenses 
menus on this page.
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Features Tab

The Features tab contains two subtabs: Summary and Details. The Details tab can also display a 
detailed feature view. Use the following links to jump to each section: 

• Summary Tab

• Details Tab

• Details Tab—Feature View

Summary Tab 

The Summary tab (default view) provides a consolidated view of feature usage on the license server. It 
groups feature records by feature name, summing up counts across different entitlements, 
activations, or product associations. This view is ideal for high-level monitoring and reporting. The 
individual columns are described in the following table:

This screenshot shows the layout of the Features tab with the Summary subtab:

Column Description

Feature The name of the feature or capability available on the license server.

Version The version number of the feature. 

Total Count The total number of license units available for this feature across all 
entitlements and activations.

Total Used The number of license units currently checked out or in use by clients.

Total Available The number of license units still available for checkout. Calculated as Total 
Count minus Total Used.

First Expiration The earliest expiration date among all line items for this feature. Helps 
identify the soonest expiring entitlement.

Last Expiration The latest expiration date among all line items for this feature. Indicates the 
longest validity period.

Total Overdraft The number of overdraft units used, if any. Overdrafts allow usage beyond the 
entitled count under specific conditions.

Metered Indicates whether the feature is metered (usage is tracked and reported) or 
not.

Counted Indicates whether the feature is counted (limited by quantity) or uncounted 
(unlimited usage allowed).
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Details Tab 

The Details tab displays all individual feature records as they exist on the license server. This granular 
view helps in troubleshooting, auditing, and understanding how licenses are distributed. The following 
table gives details about each column:

This screenshot shows the layout of the Features tab with the Details subtab:

Column Description

Feature The name of the feature or capability. Each row represents a distinct record, 
even if the feature name is the same.

Version The version of the feature. This helps differentiate between multiple releases 
of the same feature.

Count Number of license units allocated for this specific feature record.

Available The number of license units still available for checkout from this record.

Expiry The expiration date of this feature record. If marked as permanent, the 
feature does not expire.

Start Date The date from which this feature record becomes valid and available for use.

Vendor String Optional metadata defined by the producer, often used for filtering or 
categorization.
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Details Tab—Feature View 

Clicking a hyperlinked feature name on the Details subtab opens a detailed view for the selected 
feature. The view includes the following fields: 

The feature view also includes an Active Clients section, which lists the active client devices that 
currently have counts from this feature currently checked out. The following information is provided: 

Column Description

Feature Name The name of the feature or capability.

Version The version of the feature. This helps differentiate between multiple releases 
of the same feature.

Start Date The date from which this feature record becomes valid and available for use.

Total Count The total number of license units available for this feature across all 
entitlements and activations.

Available The number of license units still available for checkout from this record.

Used Count The count currently being used.

Reserved Count The number of reserved licenses within the used count.

Vendor String Optional metadata defined by the producer, often used for filtering or 
categorization.

Feature Expiry The expiration date of this feature record. If marked as permanent, the 
feature does not expire.

Column Description

Device ID The ID identifying the device that has count checked out. 
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This screenshot shows the Features tab with detailed information for a selected feature: 

Figure 7: Example of a detailed view for a selected feature.

Users can click the Back button to return to the Details subtab.

Active Clients

The Active Clients tab displays the client devices recognized by the license server as having been 
served licenses from the server’s shared pool or from licenses reserved for the client. Each client is 
identified by its device ID, the ID type, and the device type—physical, virtual, or unknown. In addition, a 
device alias might be displayed if this has been set on the device. (A device alias is also sometimes 
referred to as a device name or host name. It is a human-readable alias—in contrast to the hostid—
which can optionally be included in a capability request.)

Device ID Type The device host ID type.

Device Type The device on which the feature is used (client, served client, or license 
server).

Device Alias A user-defined name (sometimes called host name) for the device.

Total Count 
Served

The total count served to the device.

Expiry The expiration date of this feature record on the device. If marked as 
permanent, the feature does not expire.

Column Description
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Figure 8: Example of the active clients overview.

When you click the device ID for a specific client, a detailed view opens, showing details about the 
client device and the list of features currently served to the client. (Click Back to exit the page.)

Figure 9: Example of a detailed view of an active client.

Note that the Device Expiry field shows the timestamp when all currently checked-out features will 
expire on the device. This timestamp is determined either by the borrow expiration for the checked-out 
concurrent features or the final expiration date (as defined in the back office) for checked-out metered 
features.



FlexNet Operations 2025 R2 On-Premises ALM Release Notes  (April 2026)  19

The Expiry field for a feature in the Consumed Features list shows its final expiration date as defined in 
the back office.

Named License Pools

The Named License Pools tab is divided into the Existing License Pools and Upload Model File 
subtabs. The Existing License Pools subtab displays the list of named license pools that have been 
defined on the CLS instance as well as the default license pool.

When you click a license pool name, the view expands to show details about the features that are 
currently included in the license pool.

Figure 10: Example of the Named License Pools view.

The Upload Model File tab displays the model definition that is currently active on the license server. 
The model definition specifies the license pools and the rules of access that define how licenses are 
allocated to license pools (named or default). 
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Figure 11: Example of the view for uploading a model definition. 

To change the model definition, browse for the model definition that you want to use by clicking 
Browse and then click Upload.

Entitlement Management Enhancements
The following enhancements to entitlement management were added.

• Added Country Code IC (Canary Islands) to FlexNet Operations

• Bulk Upgrades with Auto Fulfillment – Increased Line Capacity

• Copy Order ID in Bulk Upgrade Operations

• Monitoring Status of FlexNet Publisher Bulk Upgrade Jobs

• Entitlement Status Change Propagates to All Associated Line Items and CLS

• New Option to Select License Email Template Variations for FlexNet Publisher Licenses

• Email Template Enhancement: Filtering Expired Activation IDs

• Setting a Default Distribution Tier Type for Entitlement Creation

• Display Account Name in Entitlement History

• Simplified Activation and Deactivation of Line Items in FlexNet Operations

Added Country Code IC (Canary Islands) to FlexNet Operations
(Cases 03569483, 03769701; SWM-29287)
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FlexNet Operations now includes the ISO 3166-1 alpha-2 reserved country code IC for the Canary 
Islands, ensuring accurate regional handling in entitlement and customer management.

The Canary Islands have a unique customs and VAT status within Spain and the EU, recognized by the 
World Customs Organization. While officially part of Spain (code ES), the reserved code IC 
acknowledges their distinct economic and customs characteristics.

This enhancement removes the need for manual workarounds when creating entitlements for 
customers in the Canary Islands and helps producers correctly manage customers in FlexNet 
Operations as per the region where an order is coming from. 

Bulk Upgrades with Auto Fulfillment – Increased Line Capacity
(Case 02984932, SWM-25091)

We've enhanced the Bulk Upgrade with Auto Fulfillment capability to support processing jobs with up 
to 6,000 line items, compared to the previous limit of 1,000. This improvement eliminates the need for 
breaking large upgrade jobs into smaller batches, significantly reducing manual effort and saving 
several hours for customers performing large-scale upgrades. 

The new capacity has been tested successfully with 6,000 line items, with jobs completing in 
approximately 1 hour and 14 minutes. If more than 6,000 items are selected, FlexNet Operations will 
prevent saving and display an error.

Copy Order ID in Bulk Upgrade Operations
(Case 02795165, 02984932; SWM-20010)

FlexNet Operations now supports copying the order ID from the parent entitlement line item to the 
upgraded line item during Bulk Upgrade operations. 

Previously, users could manually set the order ID when creating an entitlement line item. However, 
during upgrades, the order ID was not automatically carried over to the target line item.

Implementation Notes

In upgrade scenarios (for example, when Product04 is upgraded to Product05), users can now choose 
to copy the order ID from the original entitlement line to the upgraded one.

During the upgrade operation, selecting Yes for the new Copy Order ID? option (on the Entitle 
Customer To Licenses | Bulk Upgrade - Line Item Attributes page) will trigger the system to carry over 
the order ID.
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Figure 12: The new Copy Order ID? option on the Entitle Customer To Licenses | Bulk Upgrade - Line 
Item Attributes page.

To verify the that the order ID has been applied to the upgraded line item, navigate to the List 
Entitlements by Order section, where the upgraded line item will display the same order ID as its 
parent.

Additionally, when editing the upgraded entitlement, the retained Order ID is clearly visible, confirming 
successful copying.

Monitoring Status of FlexNet Publisher Bulk Upgrade Jobs
(Case 02840512, SWM-27668) 

Producers can now monitor the status of upgrade bulk operations for FlexNet Publisher licenses.

Clicking the Status column on the Entitle Customers To Licenses | Bulk Operations page (under 
Entitlements > Bulk Operations) for a FlexNet Publisher bulk operation opens the Bulk Job Status 
dialog, which displays the progress of mapping activation IDs from parent activation IDs to 
corresponding child activation IDs.
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The following table outlines how the columns in the Bulk Job Status dialog will be populated based on 
the outcome of the bulk job and the auto-fulfill configuration.

Figure 13: Example of the Bulk Job Status dialog for a successful upgrade without auto-fulfill 

Entitlement Status Change Propagates to All Associated Line Items and CLS 
(SWM-29203)

This enhancement introduces the ability for producers to seamlessly toggle the status of an 
entitlement between Active and Inactive within FlexNet Operations. Building on existing line item-level 
functionality, this feature extends license control to the entitlement level, simplifying bulk license 
management and renewal workflows.

When a producer deactivates an entitlement, all associated line items—including maintenance line 
items—automatically transition to an Inactive state. The entitlement and its associated features will be 
set to a non-deployed status in Cloud Licensing Service (CLS), ensuring that no licenses are served.

Implementation Notes

The functionality is controlled by the configuration option License server features will become inactive 
when the entitlement or line item state is changed to Inactive (under System > Configure > FlexNet 
Operations > General Options). 

This option can only be enabled both the following configuration options are unselected:

• Remove licenses from CLS when the line item state changes to Inactive/Obsolete

Scenario Parent Activation ID Child Activation ID Auto-Fulfill

Upgrade 
successful, no 
auto-fulfill

Populated Populated Blank

Upgrade 
successful, with 
auto-fulfill

Populated Populated Success or Failure

Upgrade failed Populated Blank Failure
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• Allow used entitlement/line item state change to Inactive or Obsolete

Note • This enhancement does not include data template-based entitlement updates.

New Option to Select License Email Template Variations for FlexNet 
Publisher Licenses
(Cases 02448267, 02461390; SWM-19918)

Previously, when emailing a FlexNet Publisher license to a customer, producers had the following 
options: 

• use the DEFAULT variation of the License Email template from the Send License File Via Email 
page (available by selecting a fulfillment on the Support Licenses and Maintenance page and 
clicking Email License)

• add a license template when creating a license technology on the Create a License Technology 
page (under Administer > License Technologies > Add a License Technology).

To provide more flexibility in selecting a License Email template, we added a new dropdown menu 
License Email Template variation to the Send License File Via Email page. This enables producers to 
choose any available License Email template variation from the list when sending a FlexNet Publisher 
license.

Figure 14: For FlexNet Publisher licenses, producers can select the License Email template from the 
License Email Template variation dropdown menu on the Send License File Via Email page.

This enhancement provides greater control and customization, ensuring the right template is used for 
each customer communication.

Email Template Enhancement: Filtering Expired Activation IDs 
(Cases 02429882, 02449414; SWM-9903) 
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Previously, email templates could filter line items based on state (for example, excluding drafts), but 
not based on expiration. This limitation meant that expired activation IDs could still appear in 
entitlement communications.

With the 2025 R2 release, FlexNet Operations introduces the [[Expired]] merge tag to exclude 
expired line items. This is especially useful for co-termed entitlements, where multiple subscriptions 
are aligned to renew at the same time. 

This enhancement allows customers to include only active activation IDs in their entitlement emails, 
ensuring that recipients receive relevant and current licensing information.

To use this enhancement:

• Update your DEFAULT entitlement email template to include the [[Expired]] tag logic.

• Alternatively, create a new version of the entitlement email template tailored for co-termed 
entitlements.

Example Template
XYZ Corporation grants

[[FOR-EACH TAG="Entitlement" child-only="true"]]
[[FOR-EACH TAG="ChannelPartners" child-only="true"]]
[[FOR-EACH TAG="ChannelPartner"]]

Partner Tier Name: [[PartnerTierName]]
Org Display Name: [[Name]]
Org Name: [[OrgName]]
Contact Name: [[ContactName]]

[[END FOR-EACH]]
[[END FOR-EACH]]
the right to activate the following product(s):    
[[FOR-EACH TAG="EntitlementLineItem"]]

[[IF TAG="Expired" value= "No"]]
ActivationID:    [[ActivationID]]
[[FOR-EACH tag="EntitledProduct"]]

Product Name: [[Name]]
Product Description: [[Description]]
Count: [[Count]]

[[END FOR-EACH]]
Order ID: [[OrderID]]
Quantity: [[SeatCount]]
Start Date: [[StartDate]]
Expiration Date: [[ExpirationDate]]
Expired : [[Expired]]
Permanent: [[Permanent]]
Duration :

Length: [[Length]]    
Units: [[Units]]

[[END IF]]
[[END FOR-EACH]]

The Activation IDs will be required to login. You will also need the Hostid of the computer 
with which these licenses will be associated.
If you have any questions, contact your local XYZ Corporation office.                 
Rights and restrictions on the use of the products are set forth in XYZ Corporation License 
Terms agreement.

[[END FOR-EACH]]
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Example Email

The email template above could produce an email similar to the following:

Setting a Default Distribution Tier Type for Entitlement Creation
(Cases 03569865, 03569975; SWM-28314)

This enhancement introduces a new configuration option Default Operator Used for default 
Distribution Tier Type (under System > Configure > FlexNet Operations > General Options) that allows 
producers to set a default value for the distribution tier type when creating entitlements. 

Once configured, the Distribution Tier Type dropdown menu in the End Customer And Channel 
Partners dialog (displayed when adding line items to an entitlement) is automatically populated with 
the pre-set value.

Previously, the Distribution Tier Type order was randomly set when additional partner tiers were added, 
requiring manual selection during entitlement creation. Producers with multiple partner tiers had to 
manually select the correct tier (for example, Distributor) during entitlement creation, as shown in the 
following screenshot:
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Figure 15: The Distribution Tier Type dropdown menu will be automatically populated if the option 
Default Operator Used for default Distribution Tier Type is configured.

Missing this step often led to errors and additional corrective actions.

For producers who frequently use a certain distribution tier as the initial partner tier, this enhancement 
simplifies entitlement creation and improves accuracy, reducing operational overhead.

Display Account Name in Entitlement History
(Case 02917663, SWM-24012)

Previously, in the Change History window of an entitlement (available by clicking View > View History 
on the Entitle Customers to Licenses | Create An Entitlement page), the event Channel Partner Change 
displayed only the updated account ID when the sold-to account was changed. To view the 
corresponding account name, users had to navigate to View Transactions > View details for that 
entitlement.

In the 2025 R2 release, the Change History window now includes both the account name and the 
account ID for the Channel Partner Change event for better clarity. This improvement enables users to 
immediately see account details related to entitlement changes without performing extra searches.

The following screenshot illustrates the changes: the Change History window shows the account ID 
and the name of the updated account, Delta Production Studios. 
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Figure 16: The Change History window—available by clicking View > View History in the Entitle 
Customers to Licenses | Create An Entitlement page—now displays the account name if the sold-to 
account of the entitlement is updated.

Simplified Activation and Deactivation of Line Items in FlexNet Operations
(03038349, SWM-25089)

FlexNet Operations now offers a unified and streamlined operation that allows producers to 
seamlessly toggle the status of an entitlement line item between active and inactive states. This 
enhancement allows efficient control over license allocation without requiring manual interventions, 
significantly improving operational efficiency and user experience.

Important • This enhancement is still under active development and may not perform consistently 
across all use cases. We advise using it with care and thoroughly validating any results it produces.

Overview

When a line item is marked Inactive, Cloud Licensing Service (CLS) instances will stop serving licenses 
associated with that line item. However, if the line item state is changed back to Deployed, the CLS 
instance will resume serving the license as usual. 

This behavior is controlled by a new configuration option, License server features will become inactive 
when the line item state is changed to Inactive (under System > Configure > FlexNet Operations > 
General Options). This option is disabled by default. Enable the configuration option to use this new 
functionality. 

The configuration License server features will become inactive when the line item state is changed to 
Inactive can only be enabled if both the following two configurations are disabled:

• Remove licenses from CLS when the line item state changes to Inactive/Obsolete

• Allow used entitlement/line item state change to Inactive or Obsolete.

Attempting to enable this setting while either of the above configurations is active will result in a 
conflict. In such cases, the following error message is displayed:
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"You can only enable either 'License server features will become inactive when the line item state 
is changed to Inactive' or 'Remove licenses from CLS when the line item state changes to 
Inactive/Obsolete' or 'Allow used entitlement/line item state change to Inactive or Obsolete'."

Behavior When Configuration is Enabled

When the configuration License server features will become inactive when the line item state is 
changed to Inactive is enabled and you make a line item associated with the CLS instance inactive, the 
/features endpoint will reflect this change. 

Specifically, when /features is called with the includeInactive parameter, the response will indicate 
that the feature status for the line item is marked as Inactive. 

Important • Enabling both the License server features will become inactive when the line item state is 
changed to Inactive setting and the Enable feature count aggregation option (located under System > 
Configure > FlexNet Operations > Embedded Device Settings) can prevent users from marking certain 
individual line items as Inactive. For this reason, Revenera strongly advises against activating both 
configurations simultaneously. 

Obsoleting Line Items 

When License server features will become inactive when the line item state is changed to Inactive is 
enabled, FlexNet Operations will not allow the line item state to be changed to Obsolete. If an attempt 
is made to do so, an error message will be triggered: 

"You cannot set the line item state to Obsolete while the configuration 'License server features will 
become inactive when the line item state is changed to Inactive' is enabled. Disable this 
configuration to proceed."

Limitations

Feature deactivation is not supported when using feature aggregation. Therefore, the configuration 
option Enable feature count aggregation must be deselected (under System > Configure > FlexNet 
Operations > Embedded Device Settings).

Export and Import Enhancements
The following enhancement involving the Data Export and Import functionality was added.

Removing Field Values for Download Packages Using the Download 
Packaging Template
(02840821, SWM-22856) 

Producers can now remove values from any string-accepting fields in the Download Packages 
template by entering "NULL" or "null" in the desired field. During import, these entries will result in 
blank fields, effectively clearing the original content.

In previous releases, it was not possible to remove values using the Download Package template. 
Leaving fields empty during import would retain existing values. This behavior made it challenging for 
producers to clear values in bulk.
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This enhancement applies to all non-mandatory columns that can accept a null string, for example, 
ExtendedDescription, Version, ReleaseGroup, and DownloadInstructions (non-exhaustive list). 

To determine whether a column supports null string values, refer to the column’s note. Any column 
designated to accept string input will also accept "NULL" or "null" to clear its value.

For any columns left blank in the Download Packages template, the previous behavior is unchanged. If 
a column is left blank or is removed from the template, the existing value will be retained.

Security Enhancements
The following enhancement related to FlexNet Operations security was added.

Input Validation in Accounts & Users Pages
(SWM-30769, SWM-30770)

We have added checks to prevent HTML tags being entered in user input fields on the Accounts & 
Users pages of the Producer Portal and End User Portal. 

Any attempt to submit HTML or script content on the Accounts & Users page will trigger the following 
error message: “The fields <field name> contains HTML tags. Remove these tags before saving.”

This fix improves security by blocking HTML injection. Only safe, non-HTML inputs are allowed.

Figure 17: An example of the error displayed when using HTML code on the Create A User page.

SOAP and REST Web Services Enhancements
The following enhancements were added to the SOAP and REST Web Services module:

• Retrieving Devices Not Associated to Any Account (ManageDeviceService, Version 7)

• Device Retrieval by Order Parameters (ManageDeviceService, Version 8)
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• Restriction on Modifying publisherIDname After Device Creation (ManageDeviceService, All 
Versions)

• Excluding Expired Activation from Search Results in getEntitlementLineItemPropertiesQuery 
(EntitlementOrderService, Version 9)

• New API Commands to Report Custom Attributes for Entitlements and Line Items 
(EntitlementOrderService, Version 9)

• Entitlement Order Service Now Returning Activatable Item Owner Details 
(EntitlementOrderService, Version 9)

• Optional vendorAuthString parameter in getFeaturesQueryRequest API (ProductPackagingService, 
Version 3)

• Configurable Inclusion of Line-Item Custom Attributes in Event Notifications

Retrieving Devices Not Associated to Any Account (ManageDeviceService, 
Version 7)
(Case 02874971, SWM-21765) 

The 2025 R2 release now enables producers to retrieve devices or servers that are not linked to any 
account, expanding flexibility in device management workflows.

In the ManageDeviceService SOAP web service (version 7), a new enum value IS_EMPTY has been 
added to the simpleSearchType for the searchDevices SOAP request. This allows searching for devices 
where soldToAcctId is blank.

Usage Example

To use the new IS_EMPTY searchType in a searchDevices request:

<urn:soldToAcctId>
<urn:value></urn:value>
<urn:searchType>IS_EMPTY</urn:searchType> 

</urn:soldToAcctId>

Note that the <urn:value> field must remain empty for the query to work as intended.

Note • For detailed information about the changes made to the v7/manageDeviceTypes.xsd file, see 
Ability to Retrieve Devices Not Associated to Any Account (ManageDeviceService).

Sample Request and Response for searchDevices

The following shows sample code for a searchDevices request.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v7.fne.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:searchDevicesRequest>
<urn:queryParams>

<urn:deviceClasses>
<urn:deviceClass>CLIENT</urn:deviceClass>

</urn:deviceClasses>
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<urn:soldToAcctId>
<urn:value></urn:value>
<urn:searchType>IS_EMPTY</urn:searchType>

</urn:soldToAcctId>
<urn:status>

<urn:value>ACTIVE</urn:value>
<urn:searchType>EQUALS</urn:searchType>

</urn:status>
<urn:lastModifiedDate>

<urn:value>2024-06-14</urn:value>
<urn:searchType>AFTER</urn:searchType>

</urn:lastModifiedDate>
</urn:queryParams> 
<urn:responseConfig>

<urn:name>true</urn:name>
<urn:soldTo>true</urn:soldTo>

</urn:responseConfig>
<urn:sortBys> 

<urn:sortBy>
<urn:sortKey>LAST_MODIFIED_DATE</urn:sortKey>
<urn:ascending>true</urn:ascending>

</urn:sortBy>
</urn:sortBys>
<urn:pageNumber>1</urn:pageNumber>
<urn:batchSize>25</urn:batchSize>

</urn:searchDevicesRequest>
</soapenv:Body>

</soapenv:Envelope>

The following shows sample code for a searchDevices response.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema "xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">

<soapenv:Body>
<searchDevicesResponse xmlns="urn:v7.fne.webservices.operations.flexnet.com">

<statusInfo>
<status>SUCCESS</status>

</statusInfo>
<devices>

<device>
<deviceId>

<id>Cloud purpose</id>
<idType>ETHERNET</idType>
<publisherName>fnetest</publisherName>
<deviceClass>CLIENT</deviceClass>

</deviceId>
<name>Test_5_Aug</name>
<lastModified>2024-08-05T11:30:37.333Z</lastModified>

</device>
<device>

<deviceId>
<id>a</id>
<idType>STRING</idType>
<publisherName>fnetest</publisherName>
<deviceClass>CLIENT</deviceClass>

</deviceId>
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<name>a</name>
<lastModified>2024-08-15T15:37:57.103Z</lastModified>

</device>
</devices>

</searchDevicesResponse>
</soapenv:Body>

</soapenv:Envelope>

Device Retrieval by Order Parameters (ManageDeviceService, Version 8)
(Case 04075157, SWM-29382)

The newly introduced version 8 of the Manage Device SOAP web service supports OrderID (Factory 
Order Number) and OrderLineNumber (Sales Order Number) as query parameters in getDevicesQuery 
and getDeviceCount.

This enhancement eliminates the need for multiple entitlement-based service calls, enabling:

• Direct device lookup using OrderID or OrderLineNumber

• Faster performance for large orders with hundreds of line items

• Improved scalability for cloud-based licensing portal operations

End users can now retrieve device details and counts quickly without delays caused by iterative calls.

Note • For detailed information about the changes made to the v8/manageDeviceTypes.xsd file, see 
the Efficient Device Retrieval by Order Parameters (ManageDeviceService).

Usage Examples 

The examples in this section illustrate how to use the query parameters OrderID and OrderLineNumber 
in a getDeviceCount and getDevicesQuery request.

getDeviceCount Request

Example for using the optional query parameters OrderID and OrderLineNumber in a getDeviceCount 
request:

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v8.fne.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:getDeviceCountRequest>
<!--Optional:-->
<urn:queryParams>

<!--Optional:-->
<urn:orderId>

<urn:value>2</urn:value>
<urn:searchType>EQUALS</urn:searchType>

</urn:orderId>
<!--Optional:-->
<urn:orderLineNumber>

<urn:value>14</urn:value>
<urn:searchType>EQUALS</urn:searchType>

</urn:orderLineNumber>
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</urn:queryParams>
</urn:getDeviceCountRequest>

</soapenv:Body>
</soapenv:Envelope>

getDevicesQuery Request

Example for using the optional query parameters OrderID and OrderLineNumber in a getDevicesQuery 
request:

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v8.fne.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:getDevicesRequest>
<!--Optional:-->
<urn:queryParams>

<!--Optional:-->
<urn:orderId>

<urn:value>2</urn:value>
<urn:searchType>EQUALS</urn:searchType>

</urn:orderId>
<!--Optional:-->
<urn:orderLineNumber>

<urn:value>100</urn:value>
<urn:searchType>EQUALS</urn:searchType>

</urn:orderLineNumber>
</urn:queryParams>
<urn:pageNumber>1</urn:pageNumber>
<urn:batchSize>100</urn:batchSize>

</urn:getDevicesRequest>
</soapenv:Body>

</soapenv:Envelope>

Restriction on Modifying publisherIDname After Device Creation 
(ManageDeviceService, All Versions)
(SWM-28354)

Previously, users were able to modify the publisher identity name (publisherIDname) of a device after 
its creation, even when the device’s identity had already been mapped. This led to inconsistencies in 
license management, as changing the publisherIDname could result in mismatches between devices 
and their allocated licenses, potentially causing compliance issues and inaccurate license counts.

From the 2025 R2 release onwards, users will no longer be able to change the publisherIDname once 
a device has been created and its identity is mapped. Attempts to change the publisherIDname after 
device creation will now result in an error. 

This change applies to all device updates made through the ManageDeviceService SOAP API. It 
ensures data integrity, maintains accurate license tracking, and aligns device management with 
licensing policies, ultimately reducing the risk of license misallocation and improving compliance for 
customers.
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Note • If a change to publisherIDname is necessary, the device must be deleted and recreated with the 
desired identity.

Excluding Expired Activation from Search Results in  
getEntitlementLineItemPropertiesQuery (EntitlementOrderService, Version 
9)
(Cases 03002310, 03047299; SWM-27421) 

In the EntitlementOrderService version 9, a new optional input query parameter named 
excludeExpired has been introduced for the getEntitlementLineItemPropertiesQuery to enable you to 
exclude expired activations from search results. 

• True—When excludeExpired is set to true, all expired activations—those with expiration dates 
earlier than the current local date—will be excluded from the results. 

• False—If excludeExpired is omitted or set to false, all activations, including expired ones, will be 
included.

Note • For detailed information about the changes made to the EntitlementOrderService.wsdl and 
the .xsd files that it references, see Ability to Exclude Expired Activations (EntitlementOrderService).

The following sections show sample code for getEntitlementLineItemPropertiesQuery.

Sample request for getEntitlementLineItemPropertiesQuery

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v9.webservices.operations.flexnet.com">
   <soapenv:Header/>
   <soapenv:Body>
      <urn:searchEntitlementLineItemPropertiesRequest>
         <urn:queryParams>
            <urn:isPermanent>false</urn:isPermanent>
            <!--Optional:-->
            <urn:expirationDate>

<!--type: date-->
<urn:value>2025-06-30</urn:value>
<!--type: datedSearchType - enumeration: [BEFORE,AFTER,ON]-->
<urn:searchType>BEFORE</urn:searchType>

            </urn:expirationDate>
            <urn:excludeExpired>true</urn:excludeExpired>
         </urn:queryParams>
         <urn:entitlementLineItemResponseConfig>
            <urn:activationId>true</urn:activationId>
            <urn:expirationDate>true</urn:expirationDate>
         </urn:entitlementLineItemResponseConfig>
         <!--type: integer-->
         <urn:batchSize>100</urn:batchSize>
         <!--Optional:-->
         <!--type: integer-->
         <urn:pageNumber>1</urn:pageNumber>
      </urn:searchEntitlementLineItemPropertiesRequest>
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   </soapenv:Body>
</soapenv:Envelope>

Sample response for getEntitlementLineItemPropertiesQuery

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   soapenv:Body
      <searchEntitlementLineItemPropertiesResponse 
xmlns="urn:v9.webservices.operations.flexnet.com">
         <statusInfo>
            <status>SUCCESS</status>
         </statusInfo>
         <entitlementLineItem>
            <activationId>

<uniqueId>HID-1</uniqueId>
<primaryKeys>
   <activationId>58b1-6e12-3bfa-4ffd-b1b5-45ed-11d3-019c</activationId>
</primaryKeys>

            </activationId>
            <expirationDate>2025-06-25</expirationDate>
         </entitlementLineItem>
         <entitlementLineItem>
            <activationId>

<uniqueId>HID-5</uniqueId>
<primaryKeys>
   <activationId>f479-77c6-64d5-4ba5-ac68-cdf8-d70f-9010</activationId>
</primaryKeys>

            </activationId>
            <expirationDate>2025-06-25</expirationDate>
         </entitlementLineItem>
         <entitlementLineItem>
            <activationId>

<uniqueId>HID-9</uniqueId>
<primaryKeys>
   <activationId>37e5-f876-1b8b-476f-9ed4-db83-0255-adec</activationId>
</primaryKeys>

            </activationId>
            <expirationDate>2025-06-26</expirationDate>
         </entitlementLineItem>
      </searchEntitlementLineItemPropertiesResponse>
   </soapenv:Body>
</soapenv:Envelope>

New API Commands to Report Custom Attributes for Entitlements and Line 
Items (EntitlementOrderService, Version 9)
(Case 02852081, SWM-19774) 

This release introduces version 9 of the EntitlementOrderService web service. Version 9 enables 
users to retrieve details of all custom attributes—including Entitlement, Line Item, and Maintenance 
attributes—using the operations getEntitlementsAttributeQuery and getEntitlementAttributeCount 
with the query parameters searchEntitlementAttributeRequest and 
getEntitlementAttributeCountRequest.
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The response contains an optional element activationId  for searchEntitlementAttributeRequest 
and getEntitlementAttributeCountRequest.

The new API command returns all entitlements, line items and maintenance line items with their 
custom attributes. 

Key changes:

• New version 9 of EntitlementOrderService.wsdl

• New Operations: getEntitlementsAttributeQuery, getEntitlementAttributeCount

• New Parameters: searchEntitlementAttributeRequest, getEntitlementAttributeCountRequest

Note • For detailed information about the changes made to the EntitlementOrderService.wsdl and 
the .xsd files that it references, see New API Commands to Report Custom Attributes for Entitlements 
and Line Items.

Sample Request and Response for getEntitlementsAttributeQuery

The following sections show sample code for getEntitlementsAttributeQuery.

Sample Request for getEntitlementsAttributeQuery

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v9.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:searchEntitlementAttributeRequest>
<urn:entitlementAttributeSearchCriteria>

<!--Optional:-->
<urn:entitlementId>

<urn:value>ENT_Test_AutoRenew9</urn:value>
<urn:searchType>EQUALS</urn:searchType>

</urn:entitlementId>
</urn:entitlementAttributeSearchCriteria>
<urn:batchSize>10</urn:batchSize>

</urn:searchEntitlementAttributeRequest>
</soapenv:Body>

</soapenv:Envelope>

Sample Response for getEntitlementsAttributeQuery

This sample has been condensed to fit within space constraints.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">

<soapenv:Body>
<searchEntitlementAttributeResponse xmlns="urn:v9.webservices.operations.flexnet.com">

<statusInfo>
<status>SUCCESS</status>

</statusInfo>
<entitlement>

<simpleEntitlement>
<entitlementId>
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<id>ENT_Test_AutoRenew9</id>
</entitlementId>
... 
<maintenanceLineItems>

<maintenanceProduct>
<uniqueId>HID-2000000001928</uniqueId>
<primaryKeys>

<name>Main_Test3</name>
<version>1.0</version>

</primaryKeys>
</maintenanceProduct>
<orderId>2001</orderId>
<orderLineNumber>201</orderLineNumber>
<startDate>2024-03-01</startDate>
<expirationDate>2026-02-26</expirationDate>
<isPermanent>false</isPermanent>
<parentLineItem>

<uniqueId>HID-2000000142914</uniqueId>
<primaryKeys>

<activationId>TestAct_AutoRenew</activationId>
</primaryKeys>

</parentLineItem>
<associatedLineItems>

<uniqueId>HID-2000000142914</uniqueId>
<primaryKeys>

<activationId>TestAct_AutoRenew</activationId>
</primaryKeys>

</associatedLineItems>
<maintenanceLineItemAttributes>

<attribute>
<attributeName>MLIA_ET_Boolean</attributeName>
<booleanValue>true</booleanValue>

</attribute>
<attribute>

<attributeName>TempCA1_Boolean_FNO_54060</attributeName>
<booleanValue>false</booleanValue>

</attribute>
<attribute>

<attributeName>TempCA_Boolean_FNO_54060</attributeName>
<booleanValue>false</booleanValue>

</attribute>
</maintenanceLineItemAttributes>
<state>DEPLOYED</state>

</maintenanceLineItems>
...
</entitlementAttributes>

</simpleEntitlement>
</entitlement>

</searchEntitlementAttributeResponse>
</soapenv:Body>

</soapenv:Envelope>

Sample Request and Response for getEntitlementAttributeCount

The following sections show sample code for getEntitlementAttributeCount.
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Sample Request for getEntitlementAttributeCount

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v9.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:getEntitlementAttributeCountRequest>
<urn:queryParams>

<!--Optional:-->
<urn:entitlementId>

<urn:value>ENT_Test_AutoRenew9</urn:value>
<urn:searchType>EQUALS</urn:searchType>

</urn:entitlementId>
</urn:queryParams>

</urn:getEntitlementAttributeCountRequest>
</soapenv:Body>

</soapenv:Envelope>

Sample Response for getEntitlementAttributeCount

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">

<soapenv:Body>
<getEntitlementAttributeCountResponse 

xmlns="urn:v9.webservices.operations.flexnet.com">
<statusInfo>

<status>SUCCESS</status>
</statusInfo>
<count>1</count>

</getEntitlementAttributeCountResponse>
</soapenv:Body>

</soapenv:Envelope>

Entitlement Order Service Now Returning Activatable Item Owner Details 
(EntitlementOrderService, Version 9)
(Cases 02847862, 03002310, 03004150, 03033984, 03034028; SWM-20135)

Producers can now extract information about self-registered end-users using the new version 9 of the  
EntitlementOrderService web service. This enhancement is especially useful for renewals, because it 
enables producers to tie self-registered end-users to the details in their ERP system. 

Most importantly, producers can extract the end-users’s email address that is displayed in the 
Activatable Item Owner field for a line item, as seen in this sample screenshot:
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Details of Changes to EntitlementOrderService.wsdl

The following new filters were added to getEntitlementLineItemPropertiesQuery:

• productLine: For searching a line item based on the entitled product’s product line.

• expiresIn: For searching a line item based on the expiration period. Available search units: DAYS, 
WEEKS, MONTHS, YEARS. This enables producers to filter for entitlements expiring within, for 
example, 30 days or 3 months. 

• activatableItemOwnersSearch: Can have multiple activatableItemOwner child nodes. Retrieves 
all line items that belong to either of the emails provided as child elements.

• soldToDisplayName: For searching based on the display name of the assigned account.

The following optional response field was added to getEntitlementLineItemPropertiesQuery:

• activatableItemOwners: Can have multiple activatableItemOwner child nodes. Lists all the 
owners of a given line item.
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Note • For detailed information about the changes made to the EntitlementOrderService.wsdl and 
the .xsd files that it references, see the New API Commands to Report Custom Attributes for 
Entitlements and Line Items.

Optional vendorAuthString parameter in getFeaturesQueryRequest API 
(ProductPackagingService, Version 3) 
(SWM-27118)

The getFeaturesQueryRequest API in the ProductPackagingService web service (version 3) now 
supports a new optional parameter: vendorAuthString.

The vendor auth string is used to sign license files for FlexNet Publisher licenses.  

When a non-null, non-empty value is provided for vendorAuthString, it will be included in the API 
response. This enhancement allows producers to:

• Retrieve the vendor auth string alongside other feature properties.

• Query feature information using the vendor auth string as a filter.

Note • For detailed information about the changes, see Optional vendorAuthString parameter in 
getFeaturesQueryRequest API (ProductPackagingService).

Sample Request and Response for getFeaturesQuery

The following sections show sample code for getFeaturesQuery.

Sample Request for getFeaturesQuery

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v3.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:getFeaturesQueryRequest>
<!--Optional:-->
<urn:queryParams>

<!--Optional:-->
<urn:featureName>

<!--type: string-->
<urn:value>zstart</urn:value>
<!--type: simpleSearchType - enumeration: 

[STARTS_WITH,CONTAINS,ENDS_WITH,EQUALS]-->
</urn:searchType>EQUALS</urn:searchType>

</urn:featureName>
</urn:queryParams>
<!--type: integer-->
<urn:pageNumber>1</urn:pageNumber>
<!--type: integer-->
<urn:batchSize>100</urn:batchSize>

</urn:getFeaturesQueryRequest>
</soapenv:Body>

</soapenv:Envelope>
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Sample Response for getFeaturesQuery

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">

<soapenv:Body>
<getFeaturesQueryResponse xmlns="urn:v3.webservices.operations.flexnet.com">

<statusInfo>
<status>SUCCESS</status>

</statusInfo>
<responseData>

<feature>
<uniqueId>HID-8</uniqueId>
<featureName>Zstart</featureName>
<versionFormat>DATE_BASED</versionFormat>
<version/>
<description/>
<state>DEPLOYED</state>
<vendorAuthString>AUTH={ demo=( LK=0 SIGN=0 SIGN2=0) demo2=( SIGN=0 SIGN2=0) 

}</vendorAuthString>
<featureOverrideParams>

<dupGroup>
<dupGroupOption>NO_OVERRIDE</dupGroupOption>

</dupGroup>
</featureOverrideParams>

</feature>
</responseData>

</getFeaturesQueryResponse>
</soapenv:Body>

</soapenv:Envelope>

Vendor Auth String in Producer Portal

The vendor auth string can also be displayed in the Producer Portal on the Create A Feature page 
(under Products > Features > Add new Feature):
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By default, the Vendor Auth String field is hidden. Producers who wish to have it displayed should 
contact Revenera support. 

Configurable Inclusion of Line-Item Custom Attributes in Event Notifications
(Case 04198407, SWM-30140)

A new configuration parameter has been added to the Event Notification Service REST API that allows 
system integrators to control whether line-item custom attributes are included in event notifications 
sent to a webhook URL. This parameter, includeLineItemCustomAttributes, is a boolean property 
that can be passed when calling the /notificationService endpoint using either POST (create) or PATCH 
(update). 

Unless explicitly set in a call, includeLineItemCustomAttributes defaults to false, meaning line-item 
custom attributes are excluded from the payload. When set to true, the payload include line-item 
custom attributes.

This change is fully backward compatible, ensuring that existing webhook consumers are not affected 
when the configuration is not enabled.

User Experience Enhancements
The following user experience enhancements were added.

• Enhanced Login Experience in End-User Portal

• Selectively Retriggering Failed Bulk Operations

• New Role-based Permissions for Email and View Certificate Options in End-User Portal

• Enhanced UI for Import Tab in System Configuration

• Additional Web Service Transactions Visible in Producer Portal

• Auto-Upload of Default Public Key for CLS

• Shortened Configuration Option Name

• Extended File Download Period on “Recent Files Added” Page in End-User Portal

• Enhanced Performance for Cloud Licensing Service

Enhanced Login Experience in End-User Portal
(Case 02820421, SWM-25340)

The login screen now includes a password visibility toggle to improve usability and reduce login errors. 
Users can press and hold the new eye icon to temporarily reveal their password:

• Closed eye icon (default): Password is hidden
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• Open eye icon (while pressed): Password is visible

This enhancement enables users to confirm the password they’ve entered, which is especially helpful 
in avoiding mistakes caused by caps lock, keyboard locale changes, or other typing errors.

Selectively Retriggering Failed Bulk Operations
(Cases 02840512, 02840512; SWM-25800, SWM-28102) 

Previously, when a bulk upgrade job completed but failed to upgrade entitlement line items, there was 
no way to identify which items had failed or succeeded to upgrade. This lack of visibility made it 
challenging to selectively retrigger only the failed upgrades. 
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To address this challenge, the Bulk Operations page now lists failed upgrade lines along with their 
failure reasons, which enables administrators to efficiently identify and reprocess only the failed items, 
improving both reliability and operational efficiency. This enhancement is available for entitlements 
using FlexNet Embedded and FlexNet Publisher.

Administrators can rerun failed upgrade jobs in the following ways:

• Retrigger a single job: Click the new Retry icon next to a failed job entry.

• Retrigger multiple jobs: Select the checkboxes for multiple failed jobs and click the new Retry 
button (located above the table).

This screenshot shows the Bulk Operations page with the new button and icon:

Figure 18: An example of the Bulk Operations page with the new Retry button.

New Role-based Permissions for Email and View Certificate Options in End-
User Portal
(Case 02978952, SWM-25242) 

This release introduces two new permissions to allow a more granular, role-based control over the 
visibility of the Email and View certificate menu items on the List Entitlements page in the End-User 
Portal.
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Figure 19: View of the List Entitlements page in the End-User Portal (cropped view).

Previously, the visibility of the Email and View certificate menu items was controlled globally by the 
configuration settings Hide View Certificate and Hide Email (under System > Configure > End-User 
Portal Setup > Entitlements Page). These settings applied to all users, limiting flexibility for 
organizations with diverse user roles and access needs.

To allow a more tailored access control, two new permissions have been introduced under Account 
Permissions - End-User Portal: 

• View Certificate  

• Email Licenses

These permissions allow administrators to control access to the respective menu items based on user 
roles.

Behavior Details

• The configuration takes priority. If the global configuration to hide a menu item is enabled, the 
item will remain hidden for all users, regardless of their permissions.

• If the global configuration is disabled, only users with the corresponding permission will see the 
Email or View Certificate menu items.

• By default, all existing roles that have the permission Email Licenses (listed under Operations 
License Management - Producer Portal) are granted these new permissions to maintain current 
behavior and avoid disruption.

Enhanced UI for Import Tab in System Configuration
(SWM-26018) 

The UI for Import settings (under System > Configure > Import) has been redesigned to improve 
usability and clarity.

The two sections for importing a configuration .JAR file and a digital certificate .DER file have been 
clearly separated and renamed for better understanding. The following screenshot shows the 
improved UI (for comparison, a screenshot of the previous UI can be found in Auto-Upload of Default 
Public Key for CLS).
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Figure 20: Redesigned UI of the Import section in the system configuration.

Additional Web Service Transactions Visible in Producer Portal 
(SWM-24819, SWM-24814, SWM-27695) 

The list of transactions displayed on the Search Transactions page in the Producer Portal (under 
System > Transaction History) now also includes the following transactions:

• A response was generated for a device using web services. 

• A pre-installed license is generated for a device using web services. 

• A host was returned using web services.

These enhancements are a continuation of the transparency improvements made in the previous 
release (see the FlexNet Operations 2025 R1 On-Premises Release Notes, section User Experience 
Enhancements, enhancement “Improved Transaction Visibility in Producer Portal” 

Tracked Operations In 2025 R2

Transactions are tracked for standalone devices, Cloud Licensing Service instances and local license 
servers. The following table lists the operations of the ManageDeviceService web service that are now 
tracked: 

Transaction Web Service Operation Event Type Description

Transactions tracked from release 2025 R2 onwards

https://docs.revenera.com/fno2025r1_onprem/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2025r1_onprem/rn/Content/helplibrary/User_Experience_Enhancements.htm
https://docs.revenera.com/fno2025r1_onprem/rn/Content/helplibrary/User_Experience_Enhancements.htm
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Generating a 
capability 
response

generateCapabilityRespo
nse 

UPDATE Tracks transactions where a 
capability response was generated 
for a device. 

Generating a pre-
installed license

generatePrebuiltLicense  UPDATE Tracks transactions where a pre-
installed license was generated for 
a device. 

Returning a host returnHost UPDATE Tracks transactions where the 
status of a host is set to 
"RETURNED".

Transactions tracked from release 2025 R1 onwards

Deleting a line item 
from a device

deleteAddOnLineItemsReq
uest

UPDATE Tracks transactions where an 
entitlement line item was deleted 
on a device. 

Obsoleting the 
host for a device 

obsoleteHostRequest DELETE Tracks transactions where a host 
for a device was deleted.

Removing add-on 
line items

decrementAddonLineItems
Request

UPDATE Tracks transactions where an add-
on line item was removed from a 
device. 

Moving a device to 
a different account

moveDeviceRequest UPDATE Tracks transactions where a device 
is moved to a different account. 

Deleting a device deleteDeviceRequest DELETE Tracks transactions where a device 
is deleted. 

Creating a device createDeviceRequest CREATE Tracks all successful and failed 
attempts to create a device. 

Linking 
entitlement line 
items to a device

linkAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was linked to 
a device, or where a metered 
license was removed from a 
device. 

Incrementing 
entitlement line 
items to devices

IncrementAddonLineItems UPDATE Tracks transactions where an 
entitlement line item was 
incremented on a device. 

Updating a device updateDevice UPDATE Tracks transactions where a device 
was updated.

Transaction Web Service Operation Event Type Description
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For a use case example or information about how to view transaction details, see the FlexNet 
Operations 2025 R1 On-Premises Release Notes, section User Experience Enhancements, 
enhancement “Improved Transaction Visibility in Producer Portal”. 

Auto-Upload of Default Public Key for CLS
(SWM-26018, SWM-26942)

Producers can now configure a default .DER public key in the Producer Portal. This key will be 
automatically applied to all newly created Cloud License Server (CLS) instances. It means that 
producers no longer need to manually upload the public key (.DER) file to each of their CLS instances, 
saving time and effort. 

Once a .DER file has been uploaded via the Import tab, it cannot be overwritten using the existing 
import_access_key REST API endpoint of the Cloud Licensing Service Module. Also, there is currently 
no option to view or delete an uploaded .DER file. However, you can upload a new .DER file, which will 
replace the existing one.

Producers upload the .DER file on the Import tab of the System Configuration page (under System > 
Configure). Uploaded .DER files are validated to confirm they are in the correct format. The following 
screenshot shows the new interface for the upload: 

Figure 21:  The Import tab on the System Configuration page now includes the Import Default Public 
Key button for uploading a .DER file that will be automatically applied to all newly created Cloud 
Licensing Service (CLS) instances.

https://docs.revenera.com/fno2025r1_onprem/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2025r1_onprem/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2025r1_onprem/rn/Content/helplibrary/User_Experience_Enhancements.htm
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Shortened Configuration Option Name
(SWM-26378)

The 2025 R1 release introduced a configuration which allows producers to change the behavior when 
mapping renewal licenses to devices. This configuration was called Retain mapping of the parent 
activation to the devices when mapping a child activation (available under System > Configure > 
Embedded Devices > Host Options. 

In the 2025 R2 release, the configuration name was shortened to Retain parent activation ID on 
devices/servers, to provide a better user experience. 

Extended File Download Period on “Recent Files Added” Page in End-User 
Portal
(Case 02844268, SWM-19857)

Previously, the End-User Portal allowed quick access to file downloads on the Recent Files Added 
page for recent periods of 30, 60, 90, and 120 days. To meet customer requirements, the available 
selection on the Recent Files Added page has been expanded to include a 180-day option. This 
enhancement provides greater flexibility for retrieving older content on this page.

Figure 22: The dropdown menu on the Recent Files Added list now includes a new Last 180 Days 
option.

Enhanced Performance for Cloud Licensing Service
(Cases 02869447, 02904288, 02908404; SWM-16623)

Performance upgrades to the Cloud Licensing Service (CLS) now enable faster processing and better 
scalability for high-volume operations:

Previous Performance Current Performance

Processing 200 CLS license updates took 5-7 
minutes

3,000 CLS instances mapped to a product with 
feature quantity change completed in 2 
minutes 20 seconds.
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These enhancements dramatically reduce wait times and improve efficiency for high-volume licensing 
operations.

System Requirements
Detailed system requirements for FlexNet Operations include the following.

Changes for 1,400 CLS instances took up to 1.5 
hours.

10,000 CLS license updates now processed in 
just 7 minutes.

High-volume CLS changes took up to 12 hours.

Requirement Description

Web browsers • Microsoft Edge 

• Mozilla Firefox 75.0 

• Google Chrome 80.0.3987.163 

FlexNet licensing module • FlexNet Publisher Toolkit 11.12.0 or later 

• FlexNet Embedded Toolkit 2015 R2 or later 

Note • FlexNet Operations supports these FlexNet Embedded 
host ID types: ETHERNET, INTERNET, INTERNET_6, FLEXID9, 
FLEXID10, STRING, USER, VM_UUID, EXTENDED, 
PUBLISHER_DEFINED, and CONTAINER_ID.

Vendor certificate generator The current versions of the VCG kit are 12.11.0 and 16.2.2.0. 

These VCGs were tested with the following compilers: 

• Windows—Visual Studio 2010 Professional Edition 

• Linux—gcc 4.1.2 (RHEL 5.0) 

• Linux—gcc 4.4.4 (RHEL 6.0) 

Note • The 12.11.0 VCG is built with FlexNet Publisher 11.11.1 
and shares the same minimum C compiler requirements on each 
supported platform. (See the FlexNet Publisher 11.11.1 release 
notes for C/C++ compiler support.) 

Previous Performance Current Performance
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Resolved Issues
Issues in the following areas were resolved in the FlexNet Operations 2025 R2 On-Premises release:

• Account and User Management Issues Resolved

• Device Management Issues Resolved

• Entitlement Management Issues Resolved

• License Management Issues Resolved

• Security Issues Resolved

• SOAP and REST Web Services Issues Resolved

• User Experience Issues Resolved

Account and User Management Issues Resolved
The following issues involving the management of accounts and users were resolved in the 2025 R2 
release.

• Account-Level Restrictions on Obsoleting Devices and Servers

• Role Details Page in End-User Portal Now Loads Without Error

• Expanded Permissions for Merging Entitlements

• New Permission for Managing Part Numbers

Account-Level Restrictions on Obsoleting Devices and Servers
(SWM-30699)

Previously, in the End-User Portal, users with the Obsolete Devices/Servers permission could mark 
devices or servers as obsolete even if those assets belonged to a different account. This behavior was 
unintended and violated account-level restrictions.

This issue has been fixed. Users can now only mark devices or servers as obsolete within their own 
account.

Role Details Page in End-User Portal Now Loads Without Error
(SWM-29535)

Previously, clicking on any role link within the Edit Account or Edit User pages in the End-User Portal 
triggered an error message, preventing users from accessing role-specific information.

High Speed File Upload If you intend to use the High Speed Upload option to upload files, 
the following plug-in is required:

Aspera Connect 3.10.0 or later

Requirement Description



FlexNet Operations 2025 R2 On-Premises ALM Release Notes  (April 2026)  53

Figure 23: Clicking a role (highlighted in red) resulted in an error message.

This issue has now been resolved. Clicking a role link correctly opens the Role Details page, which 
displays the permissions associated with that role.
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Figure 24: In 2025 R2, clicking a role now opens the Role Details page.

This enhancement improves usability by allowing customers to easily view and understand the 
permissions tied to their roles, supporting better transparency and role management.

Expanded Permissions for Merging Entitlements
(Case 03042145, SWM-26989)

In earlier releases, only users with the View and Manage Users permission could reassign users to 
other accounts. Users with only the View and Manage Customer Users permission were restricted, as 
the relevant Users checkbox on the List Entitlements by Order | Merge Entitlements page (under 
Entitlements > Merge) was disabled.
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Figure 25: The Merge Entitlements page showing the active Users checkbox, available to users with 
the View and Manage Customer Users or View and Manage Users permission.

This restriction has been lifted in the 2025 R2 release. Users who hold either the View and Manage 
Customer Users permission or the View and Manage Users permission—or both—can now reassign 
users to other accounts.

New Permission for Managing Part Numbers
(SWM-27450)

Previously, users with the View Products, Suites, and Maintenance permission could still perform 
Create, Update, and Delete operations on part numbers.

To support more granular access control, the 2025 R2 release updates the existing Create Part 
Numbers permission—renaming it to Manage Part Numbers and expanding its scope. This revised 
permission now explicitly governs the ability to add, modify, or delete part numbers.

Roles that previously included the Create Part Numbers permission have been automatically updated 
to include Manage Part Numbers, ensuring continuity of access for affected users.

Only users assigned a role that includes Manage Part Numbers can perform these operations. Users 
that do not have the Manage Part Numbers permission will no longer have access to part number 
management actions.

Device Management Issues Resolved
The following issues involving the management of devices were resolved.

• Email Notifications for Obsolete Inactive Devices Job Alert

• Fixed Label on Named License Pools Tab for Cloud License Server

Email Notifications for Obsolete Inactive Devices Job Alert 
(Case 03032649, SWM-29520)
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Previously, users subscribed to the alert for the Obsolete Inactive Devices job did not receive email 
notifications after the job was executed because no email template was associated with the alert. 

This issue has been fixed by adding a new template that sends notifications to subscribed users when 
the job runs. The email now includes details such as the inactivity date and the number of devices that 
were obsoleted.

The following screenshot shows an example of an email based on the new template:

Note • The alert templates do not appear on the Templates page and cannot be modified by users.

Fixed Label on Named License Pools Tab for Cloud License Server
(FNE-23801)

Previously, on the newly introduced Named License Pools tab (on the Cloud License Server Details 
page), the Existing License Pools subtab displayed the feature name next to the pool ID instead of the 
expected license pool name. This mislabeling has been fixed in the 2025 R2 release: 
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Figure 26: The list on the Existing License Pools subtab now correctly shows the license pool names.

Entitlement Management Issues Resolved
The following issues were resolved for entitlement management in the 2025 R2 release.

• Updating Line Item Quantity Via Web Services

• Preventing Deployment of Inactive Line Items When Entitlement Is Inactive

• Fixed Incorrect Date Display on Active Clients Tab

• Resolved Bulk Upgrade Failures with Custom License Generators

• Corrected Display of Account Name in Email Templates

• Upgrade Activation Warning Extended to Activation ID Logins

• Faster Attribute Search

• Correct Line Item Selection in Entitlement Notification Emails

Updating Line Item Quantity Via Web Services 
(Cases 03042184, 04103062; SWM-27652)

Previously, FlexNet Operations returned an error when attempting to update the quantity of a deployed 
line item through web services under the following system configuration settings (both under System 
> Configuration > FlexNet Operations > General Options):

• Update line item count of deployed line item was selected.

• Allow Editing of Deployed Entities was unselected.

This behavior was incorrect, as the first setting should allow quantity updates even when deployed.
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The issue has been resolved. Users can now successfully update the quantity of a deployed line item 
using web services when the above configuration is applied.

Preventing Deployment of Inactive Line Items When Entitlement Is Inactive
(SWM-29442)

Previously, the system allowed inactive line items to be deployed even when their associated 
entitlement was inactive. This behavior could lead to inconsistencies by permitting deployments that 
should not occur.

The issue has been fixed. The system now prevents deployment of an inactive line item if its 
entitlement status is inactive. When such an attempt is made, an error message is displayed:

“Cannot deploy line item <activation id>. The parent entitlement <entitlement id> is not deployed.”

Figure 27: Screenshot showing the error message when attempting to deploy a line item whose 
entitlement status is inactive (Draft).
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Fixed Incorrect Date Display on Active Clients Tab
(SWM-30473)

Previously, on the Cloud License Server Details page, the Active Clients tab displayed incorrect date 
values. The Expiry Date column showed the start date, and the Start Date column showed the expiry 
date. 

Figure 28: Example of the reversed dates on the Active Clients tab.

This issue did not affect the dates in the line item itself, as shown by this screenshot for the same 
entitlement line item:
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Figure 29: The actual line item dates were correct.

This issue no longer occurs in the 2025 R2 release. 

Resolved Bulk Upgrade Failures with Custom License Generators
(Case 03036320, SWM-26777)

Bulk upgrade operations no longer fail when a custom license generator is used to generate the 
upgraded licenses.

Corrected Display of Account Name in Email Templates
(Case 04171893, SWM-29538)

The [[Name]] merge tag in some email templates was previously resolving to a value from the License 
Model custom attribute instead of the intended Account Name. While previews showed the correct 
value, the final email output showed an incorrect value.

The following templates were affected: 

• License Template

• Multiple Licenses Template

• Consolidated License

• Multiple Consolidated Licenses

This issue has been fixed. The [[Name]] tag now correctly resolves to the Account Name in all relevant 
templates.
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Upgrade Activation Warning Extended to Activation ID Logins 
(Case 02733304, SWM-27200)

The 2025 R1 release introduced a new configuration option Display warning message when activating 
upgrade line item linked to parent line item (under System > Configure > FlexNet Operations > 
General Options). The option controls whether the Producer Portal and the End-User Portal displays a 
warning message to alert users that activating a certain upgrade line item means that they can no 
longer activate previous versions of that line item. For details, see the FlexNet Operations 2025 R1 On-
Premises Release Notes, section Entitlement Management Enhancements, enhancement “Warning 
Message When Activating Licenses for Upgrade Line Items”. 

However, the changes made in 2025 R1 meant that the warning message (if configured) would only be 
displayed in cases where the user logs into the End-User Portal using their user name or entitlement 
ID. The warning was not displayed when a user logged in using an activation ID and then proceeded to 
activate an upgrade line item by navigating to the List Entitlements page, selecting an entitlement and 
clicking Activate.

The 2025 R2 release now addresses this gap. If Display warning message when activating upgrade 
line item linked to parent line item is selected, and a user tries to activate an upgrade line item that is 
linked to the parent line item, the following warning is displayed:

“If you activate the selected upgrade line item, you will no longer be able to activate previous 
versions of that line item. Are you sure you want to activate the upgrade line item?“

This warning will be displayed irrespective of whether the user logged into the End-User Portal using a 
user name, entitlement ID, or activation ID.

Faster Attribute Search
(SWM-27365)

Previously, performing advanced searches on custom entitlement attributes, custom attributes, and 
custom line item attributes resulted in slow response times on the List Entitlements by Order and List 
Entitlements pages.

In the 2025 R2 release, the underlying queries have been optimized, significantly improving response 
times for these advanced searches. Users can now expect faster and more efficient retrieval of 
entitlement data when using custom attribute filters.

Correct Line Item Selection in Entitlement Notification Emails
(Case 03047793, SWM-27343)

In the 2025 R1 release, an enhancement was introduced to allow producers to select individual line 
items on the List Entitlement By Orders page for inclusion in entitlement notification emails, rather 
than including all line items in the notification email by default. 

Previously, this functionality did not work as intended: while the email preview displayed only the 
selected line items, the actual email sent to customers included all line items, ignoring the applied 
filters.

This issue has now been fixed. The system correctly sends entitlement notification emails containing 
only the line items selected by the producer.

https://docs.revenera.com/fno2025r1_onprem/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2025r1_onprem/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2025r1_onprem/rn/Content/helplibrary/Entitlement_Management_Enhancements.htm
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License Management Issues Resolved
The following issue involving license management has been resolved.

Filtering By Predefined Host Type
(SWM-25288)

In earlier versions, searches on the Support Licenses and Maintenance | Hosts page (under Licenses > 
Hosts) using predefined host types—such as Server, Nodelocked, Custom, and Trusted—did not return 
any results, even though searches using custom host type names functioned correctly.

As of release 2025 R2, this issue has been resolved. Searches using predefined host types now return 
the expected host records, ensuring consistent and reliable search behavior across all host type 
categories.

Security Issues Resolved
The following issues related to FlexNet Operations security were addressed.

• Resolved Access Control Vulnerability for Agreements

• Enforced Permission Checks for License Pages in Producer Portal

• JWT Signature Verification for apiCookie Requests

• Secure Access to Swagger Documentation

• Phone Number Validation on Edit Profile Page

• Special Character Validation for Accounts & Users in End-User Portal

• HTML Injection Vulnerability Mitigation Across FlexNet Operations

• Access Restriction on Email Templates Module

• Encoding of Special Characters in Role Names and Descriptions
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Resolved Access Control Vulnerability for Agreements 
(SWM-28053, SWM-30096)

This release addresses a broken access control vulnerability that allowed low-privilege users to access 
transaction details for agreements they were not authorized to view (under Products > List 
Agreements).

The 2025 R2 release introduces a refined access control model: 

• Download and Update operations are restricted to high-privilege users.

• View and Search operations are permitted for low-privilege users, enabling them to locate and 
inspect transactions they are authorized to access, without compromising data security.

This change ensures that only high-privilege users can modify or extract transaction data, while still 
allowing basic visibility for low-privilege users. The update aligns with best practices for role-based 
access control and enhances usability without sacrificing security.

Enforced Permission Checks for License Pages in Producer Portal 
(SWM-29912)

This release resolves a vulnerability in the Producer Portal, where low-privilege users could access 
restricted license-related pages via direct URLs.

Prior to this fix, users without access to certain pages available from the Licenses menu could bypass 
UI restrictions and access the following pages directly by navigating to the corresponding URL:

• Licenses > Support Licenses and Maintenance

• Batch Rehost > Support Licenses and Maintenance | Batch Rehost - Select Customer Account and 
Hosts 

• Transfer Licenses > Support Licenses and Maintenance | Transfer Licenses 

• Host Transfer Jobs > Host Transfer Jobs

• Manual Activation > Manual Activation

This behavior allowed unauthorized users to perform actions reserved for higher-privilege roles. 
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Figure 30: Low-privileged users could access the highlighted menu items via direct URLs. 

To prevent unauthorized access, permission checks have now been enforced for each of the above 

pages. The required permissions are as follows:

This update ensures that only users with the appropriate role-based permissions can access and 
perform actions on these pages, thereby aligning with best practices for secure access control.

JWT Signature Verification for apiCookie Requests
(SWM-29861)

Previously, requests containing apiCookie were not validated for JWT (JSON Web Token) signature 
integrity. This posed a potential security risk by allowing tokens with invalid signatures to be 
processed.

UI Path and Page Header Required Permissions

Licenses > Support Licenses and 
Maintenance

View Licenses

Batch Rehost > Support Licenses and 
Maintenance | Batch Rehost - Select 
Customer Account and Hosts 

View Licenses and Rehost Licenses

Transfer Licenses > Support Licenses 
and Maintenance | Transfer Licenses 

View Licenses and Rehost Licenses

Host Transfer Jobs > Host Transfer 
Jobs

View Licenses

Manual Activation > Manual Activation View Licenses and Manual Activation
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Starting with the 2025 R2 release, JWT signature verification can be enforced for all apiCookie 
requests. Any request with an invalid JWT—such as a tampered or malformed signature—will result in 
a 401 Unauthorized response and redirect the user to the No Access page:

This change enhances security by ensuring only valid tokens are accepted, preventing unauthorized 
access and improving the security of the application.

Note • JWT signature verification is disabled by default. Customers who wish to enable this feature 
should contact Support.

Secure Access to Swagger Documentation
(SWM-28832)

As of the 2025 R2 release, direct access to the Swagger documentation hosted at 
https://<siteID>.flexnetoperations.com/flexnet/swagger-ui.html is no longer permitted without 
authentication. Users attempting to access this page are now redirected to the FlexNet Operations 
login screen. Upon successful login, the Swagger interface is displayed. No additional permissions are 
required.

This change ensures that sensitive endpoints—such as token controllers—are only visible to 
authenticated FlexNet Operations users, strengthening platform security and protecting critical API 
resources.

Phone Number Validation on Edit Profile Page
(SWM-28833)

Previously, users could enter malformed or otherwise invalid values into the Phone field when editing 
their profile; such as non-numeric characters, incorrectly short or long numbers, or missing required 
digits. 
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The 2025 R2 release introduces validation for the Phone field on the Edit Profile page (available by 
opening the User menu and clicking My Profile). The field now enforces acceptable phone-number 
formats, rejects inputs with invalid characters or incorrect length, and normalizes input where 
appropriate.

Figure 31: User input in the fields Phone and Country is validated.

Validation Rules and Handling of Failed Validation

The following validation rules apply to the Phone field:

• Allowed characters: digits (0-9), hyphens (-), plus signs (+), and spaces.

• Examples: +91 9123456789, 07123 456789, +1-555-867-5309

• If a user attempts to save a profile with a phone number containing invalid characters, this error 
message will appear: 

“Phone number must contain only digits and allowed symbols.”

Additionally, the phone number must correspond to the country selected in the Country dropdown:

• If the phone number does not match the selected country’s format or numbering plan, the 
following error message is displayed:

“Invalid phone number for the selected country.”

• Example: The phone number 07123 456789 with the country set to United States will be flagged as 
invalid for the selected country.
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Special Character Validation for Accounts & Users in End-User Portal 
(SWM-28834)

To improve data integrity and prevent malformed input, the 2025 R2 release introduces validation for 
special characters in the input fields for all submenus under Accounts & Users in the End-User Portal. 
Fields now reject entries containing disallowed characters such as :<>{}@;=\,!/|?"#$%~^'`.

If a user attempts to enter invalid characters—for example, in the First Name field—they will receive 
the following error message:

“The field [First Name] contains the following illegal characters: :<>{}@;=,!/|?"#$%~^`'. Remove 
these characters before saving.”

No validation is currently applied to fields where special characters are typically expected, such as 
Description, Address 1 and Address 2. Special character checks for these fields will be introduced in a 
future release.

This update helps ensure consistent and clean data entry across key user and account fields.

HTML Injection Vulnerability Mitigation Across FlexNet Operations
(SWM-28025, SWM-28027, SWM-28029, SWM-28050, SWM-28051)

FlexNet Operations was found to be vulnerable to HTML injection across several input fields in both the 
End-User Portal and the Producer Portal. The affected areas included:

• Fields in the End-User Portal on the Create Account and Edit Account pages:

• Account ID

• Account Name

• Fields in the Producer Portal on the Create Server Host Type page and Edit Server Host Type 
pages:

• Server Host Type Name

• Description

• Name

• Fields in the Producer Portal on the Entitle Customers to Licenses page:

• Description

• Ship-to email

• Ship-to mail

• Fields in the Producer Portal on the Device | New Device page: 

• Name

• ID

• Site Name

• Notes

• Fields in the Producer Portal on the Update page (Products > Updates > Create):
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• Name

• Update ID

• Description

Mitigation and Improvements

To mitigate HTML injection vulnerabilities, input sanitization and validation mechanisms have been put 
in place. These enhancements ensure that affected fields now properly detect and neutralize malicious 
HTML content. As a result, the application's security posture is strengthened, effectively preventing 
cross-site scripting (XSS) attacks and promoting safe handling of user-supplied data. 

Any attempt to include HTML tags in restricted fields now triggers specific error messages to prevent 
misuse and guide users, as shown in the following screenshots:

• Creating/Editing an Account: 

Figure 32: Error message when attempting to use HTML in the input fields of the Edit Account 
page.

• Creating/Editing a Server Host Type: 
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Figure 33: Error message when attempting to use HTML in the input fields of the Create Server 
Host Type page.

• Creating/Editing an Entitlement: 
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Figure 34: Error message when attempting to use HTML in the input fields of the Entitle 
Customers To Licenses | Create An Entitlement page.

• Creating a Device:

Figure 35: Error message when attempting to use HTML in the input fields of the Create Device 
page.

• Creating an Update:
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Figure 36: Error message when attempting to use HTML in the input fields of the Update page.

Note • These changes do not affect existing fields that already contain HTML tags. 

Access Restriction on Email Templates Module
(SWM-28022)

Previously, low-privilege users were able to access the Email Templates module through force 
browsing, bypassing intended access controls.

With this release, access control has been enforced. Low-privilege users can no longer access the 
Email Templates module, even via force browsing attempts.

If a low-privilege user attempts to access the module through force browsing, they will now be 
presented with a "No Access" error message on the FlexNet Operations UI:

Figure 37: Error message when a low-privilege user attempts to access the Email Templates module.
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Encoding of Special Characters in Role Names and Descriptions 
(Case 02889178, SWM-22286)

To enhance security and prevent potential vulnerabilities, role names and descriptions that include 
specific special characters are now encoded before being stored in the database. These values are 
automatically decoded when displayed to users.

If a role name or description contains any of the special characters listed in the following table, it will 
be encoded using hexadecimal format during storage. Upon retrieval, the encoded values are decoded 
to ensure proper display in the user interface.

Character Name

! Exclamation mark

“ Quotation mark (double quote)

# Number sign (hash or pound)

$ Dollar sign

% Percent sign

& Ampersand

' Apostrophe (single quote)

( Left parenthesis

) Right parenthesis

* Asterisk

+ Plus sign

, Comma

- Hyphen (minus sign)

. Period (dot)

/ Slash (forward slash)

: Colon

; Semicolon

< Less-than sign

= Equals sign
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This change applies to existing roles as well as newly created roles.

Note • Role names containing any of the special characters listed in the table will be stored in an 
encoded format in the Reporter database.

Updating Users with Existing Roles with Special Characters

When an existing role name contains special characters, calling the updateUser operation of the 
UserAcctHierarchy SOAP web service will return the error "Invalid Role Name". 

As a workaround, save the role name using the Roles page in the Producer Portal. This ensures that 
the role name is converted to encoded format in the database. Once the role has been saved, calling 
updateUser will no longer return an error. 

This issue does not occur when managing roles via the Producer Portal.

Adding or Editing Roles

Role names and descriptions are entered in the Producer Portal on the Add Role page (available by 
clicking Accounts & Users > All Roles > Add), as shown in this screenshot:

> Greater-than sign

? Question mark

@ At sign

[ Left square bracket

] Right square bracket

^ Caret

_ Underscore

` Grave accent

{ Left curly brace

| Vertical bar (pipe)

} Right curly brace

~ Tilde

Character Name
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Figure 38: The Add Role page with the Name and Description fields. 

To edit a role, click Accounts & Users > All Roles to open the Roles page. Then click a role name, make 
your edits and save. 

SOAP and REST Web Services Issues Resolved
The following issues related to FlexNet Operations Web Services were addressed.

• Creation of Simple Entitlement of Type NEW No Longer Failing (EntitlementOrderService)

• EntitlementOrderService No Longer Returning Error for accountUnitName Query

• upgradeLicenseRequest Now Correctly Establishes Upgrade Relationship Between Entitlement 
Line Items (EntitlementOrderService)

• updateEntitlementLineItem Web Service Now Supporting Upsells and Renewals 
(EntitlementOrderService)

• Transferring Line Items of Type Upgrade Order Using SOAP API (EntitlementOrderService)

• Case Sensitivity in DownloadPackagingService Authentication (DownloadPackagingService)

• Country Code Validation in createUser API (UserAcctHierarchyService)

• updateProduct API Call No Longer Fails to Update Product Fields (ProductPackagingService)

Creation of Simple Entitlement of Type NEW No Longer Failing 
(EntitlementOrderService)
(SWM-25523)

In the EntitlementOrderService SOAP API, requests to create a simple entitlement with LineItemType 
set to NEW no longer fail with a Null Pointer error. 

Sample Request and Response

The following shows sample code for createSimpleEntitlementRequest.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v9.webservices.operations.flexnet.com">
   <soapenv:Header/>
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  <soapenv:Body>
      <urn:createSimpleEntitlementRequest>
         <urn:simpleEntitlement>
            <urn:entitlementId>
               <urn:autoGenerate>true</urn:autoGenerate>
            </urn:entitlementId>
            <urn:description>aeoliam venit</urn:description>
            <urn:lineItems>
               <urn:activationId>
                  <urn:autoGenerate>true</urn:autoGenerate>
               </urn:activationId>
               <urn:description>profundum quippe ferant</urn:description>
               <urn:product>
                  <urn:primaryKeys>
                     <urn:name>embedded prod 1</urn:name>
                     <urn:version>1.0</urn:version>
                  </urn:primaryKeys>
               </urn:product>
               <urn:licenseModel>
                  <urn:primaryKeys>
                     <urn:name>Embedded Counted</urn:name>
                  </urn:primaryKeys>
               </urn:licenseModel>
               <urn:numberOfCopies>100</urn:numberOfCopies>
               <urn:startDate>2025-02-02</urn:startDate>
               <urn:startDateOption>DEFINE_NOW</urn:startDateOption>
               <urn:isPermanent>true</urn:isPermanent>
                 <urn:lineItemType>NEW</urn:lineItemType>
            </urn:lineItems>
            <urn:autoDeploy>true</urn:autoDeploy>
            <urn:allowPortalLogin>false</urn:allowPortalLogin>
         </urn:simpleEntitlement>
         <urn:opType>CREATE_OR_UPDATE</urn:opType>
      </urn:createSimpleEntitlementRequest>
   </soapenv:Body>
</soapenv:Envelope>

The following shows sample code for createSimpleEntitlementResponse.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
   <soapenv:Body>
      <createSimpleEntitlementResponse xmlns="urn:v9.webservices.operations.flexnet.com">
         <statusInfo>
            <status>SUCCESS</status>
         </statusInfo>
         <responseData>
            <createdSimpleEntitlement>
               <recordRefNo>1</recordRefNo>
               <uniqueId>HID-27</uniqueId>
               <entitlementId>8ab0-c12b-269c-4243-8730-5e6d-de71-2da9</entitlementId>
               <lineItemUniqueIds>HID-12</lineItemUniqueIds>
               <lineItemIdentifiers>
                  <uniqueId>HID-12</uniqueId>
                  <primaryKeys>
                     <activationId>5ea5-2297-fa56-4344-b9c0-fc20-302e-cdeb</activationId>
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                  </primaryKeys>
               </lineItemIdentifiers>
            </createdSimpleEntitlement>
         </responseData>
      </createSimpleEntitlementResponse>
   </soapenv:Body>
</soapenv:Envelope>

EntitlementOrderService No Longer Returning Error for accountUnitName 
Query
(Case 03955183, SWM-29389)

In the previous release, using the accountUnitName query parameter with the EQUALS operator in 
certain EntitlementOrderService operations (versions 1 through 7) could incorrectly trigger error 
21073—“Count of Account names exceeded the limit of 10”—if the specified account name contained 
a space.

The following operations were impacted: 

• getActivatableItemCount

• getActivatableItemsQuery

• getEntitlementLineItemPropertiesQuery

This issue has been resolved.

As part of the fix, versions 8 and 9 of EntitlementOrderService now use the newly introduced 
accountUnitNameList parameter, which accepts multiple account names. Customers can provide 
multiple account unit names using repeated <urn:value>?</urn:value> elements.

Example for Using accountUnitNameList

The following example code shows how to pass multiple account names.

<soapenv:Body>
<urn:searchEntitlementLineItemPropertiesRequest>

<urn:queryParams>
<urn:accountUnitNameList>

<!--1 or more repetitions:-->
<urn:value>Road Runner Corporation</urn:value>
<urn:value>Acme Corporation</urn:value>
<urn:value>Wily Inc.</urn:value>

</urn:accountUnitNameList>
</urn:queryParams>

...
</soapenv:Body>

Note • For detailed information about the changes made to the EntitlementOrderService.wsdl and 
the .xsd files that it references, see the Entitlement Order Service Now Accepts Multiple Account 
Names.
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Guidelines for Using accountUnitName and accountUnitNameList

• In versions 1 through 9, use the accountUnitName parameter for operations that require only a 
single account name. Account names may include spaces. 

• In versions 8 and 9, use the accountUnitNameList parameter for operations that require multiple 
account names, for example, getEntitlementLineItemPropertiesQuery. Account names may 
include spaces. 

Note • By default, you can pass up to ten account names, or as defined by the configuration option 
Maximum number of Account names accepted to search for Entitlement Line Item Properties.

upgradeLicenseRequest Now Correctly Establishes Upgrade Relationship 
Between Entitlement Line Items (EntitlementOrderService)
(Case 02760756, SWM-16718)

Previously, the upgradeLicense operation of the EntitlementOrderService SOAP web service (all 
versions) failed to create an upgrade relationship between entitlement line items. When submitting an 
UpgradeLicenseRequest to create an upgrade line item for a product configured with an Embedded 
Counted license model, the request returned a NullPointerException.

This issue has been resolved. The upgradeLicense operation now correctly establishes the upgrade 
relationship between line items when the upgrade path is defined between products. 

updateEntitlementLineItem Web Service Now Supporting Upsells and 
Renewals (EntitlementOrderService)
(SWM-22395)

The updateEntitlementLineItem method of the EntitlementOrderService web service has been 
enhanced to support Upsell and Renewal operations through the lineItemType field. 

This enhancement improves automation capabilities for producers managing complex product 
relationships. 

Previously, attempts to set an upsell or renewal relationship between entitlement line items using the 
updateEntitlementLineItem operation were unsuccessful. Although the operation returned a SUCCESS 
response, the line item type remained unchanged (e.g., stayed in NEW state).

To address this, the updateEntitlementLineItem method has been enhanced to support UPSELL and 
RENEWAL values for the lineItemType field. When there are multiple entitlement line items, the 
updateEntitlementLineItem method can be used to establish Upsell and Renewal relationships 
between two valid line items.

The enhancement affects the EntitlementOrderService web service version 7 and above.

The following section shows sample code for updateEntitlementLineItem.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v8.webservices.operations.flexnet.com">
   <soapenv:Header/>
   <soapenv:Body>
      <urn:updateEntitlementLineItemRequest>
         <!--1 or more repetitions:-->
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         <urn:lineItemData>
            <urn:entitlementIdentifier>
               <urn:primaryKeys>
                  <urn:entitlementId>Ent_150</urn:entitlementId>
               </urn:primaryKeys>
            </urn:entitlementIdentifier>
            <!--Zero or more repetitions:-->
            <urn:lineItemData>
               <urn:lineItemIdentifier>
                  <urn:primaryKeys>
                     <urn:activationId>c3a8-da3d-ba22-4014-a7ac-2e18-55cf-
289d</urn:activationId>
                  </urn:primaryKeys>
               </urn:lineItemIdentifier>
               <urn:product>
                  <urn:primaryKeys>
                     <urn:name>p00002</urn:name>
                     <urn:version>1.0</urn:version>
                  </urn:primaryKeys>
               </urn:product>
               <urn:licenseModel>
                  <urn:primaryKeys>
                     <urn:name>akFloatingCounted</urn:name>
                  </urn:primaryKeys>
               </urn:licenseModel>
               <urn:parentLineItem>
                  <urn:primaryKeys>
                     <urn:activationId>ffbd-b450-176f-4570-a7b6-d260-4b63-
0166</urn:activationId>
                  </urn:primaryKeys>
                  <!--Optional:-->
                  <urn:lineItemType>UPSELL</urn:lineItemType>
               </urn:parentLineItem>
               </urn:lineItemData>
            <urn:autoDeploy>false</urn:autoDeploy>
         </urn:lineItemData>
      </urn:updateEntitlementLineItemRequest>
   </soapenv:Body>
</soapenv:Envelope>

If valid values for an existing lineItem are provided as parentLineItem, and the lineItemType is set to 
UPSELL, a new upsell relationship will be created between the lineItemIdentifier and the 
parentLineItem.

Similarly, if valid values for an existing lineItem are provided as parentLineItem, and the lineItemType 
is set to RENEWAL, a new renewal relationship will be created between the lineItemIdentifier and the 
parentLineItem.

Transferring Line Items of Type Upgrade Order Using SOAP API 
(EntitlementOrderService)
(Case 02974592, SWM-24805)
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In earlier releases, when transferring line items of type Upgrade Order from one entitlement to another 
via the EntitlementOrderService SOAP API, the operation failed with the following error: “Trusted or 
embedded license models cannot be set to line item <ID>; it is not a new order and does not have a 
parent defined.” The error occurred for line items using Trusted or Embedded license models.

However, the same action succeeded when it was performed through the Producer Portal UI (see the 
User Guide topic Transfer Entitlement Line Item Wizard for procedural information).

In the 2025 R2 release, upgrade order line items can be transferred without issue using the 
transferLineItems operation of the EntitlementOrderService SOAP API, which creates parity with 
the Producer Portal functionality.

To allow the transfer of upgrade order line items, the new configuration option Allow transfer of child 
line items for upgrades via SOAP must be selected. The option is located under System > 
Configuration > FlexNet Operations > General Options. It is unselected by default. 

Case Sensitivity in DownloadPackagingService Authentication 
(DownloadPackagingService) 
(Cases 03047680, 04214918; SWM-27781)

The DownloadPackagingService previously failed to authenticate users when the username contained 
uppercase letters, due to case-sensitive handling of credentials. This issue has now been resolved by 
updating the authentication logic to treat usernames in a case-insensitive manner, ensuring 
consistent and successful authentication regardless of letter casing.

Country Code Validation in createUser API (UserAcctHierarchyService)
(SWM-26045, SWM-27390) 

Starting with the 2025 R2 release, the createUser API of the UserAcctHierarchyService web service 
now validates the provided two-letter country code (if a code country is specified). If the country code 
is invalid, the request fails and the API returns an error: ‘Invalid country code format. Enter a valid two-
letter country code based on the ISO 3166-1 Alpha-2 code standard, such as "US" or "CA".’ 

The validation is performed in all versions of the UserAcctHierarchyService web service. 

Specifying a country code is optional. If provided, the country codes must follow the two-letter format 
based on the ISO 3166-1 Alpha-2 standard. If no country code is provided, the user will be created 
with the default country code “US” (United States). 

Note • The default country code can be changed under System > Configure > FlexNet Operations > 
General Options > Default Country for Users and Account Addresses.

This change addresses an issue whereby users created without a supported country code were 
previously instead assigned a default country code, which resulted in incorrect data. These users were 
not synced with the Electronic Software Delivery (ESD) system and were therefore unable to access 
their software downloads in the End-User Portal. In addition, because a default country code was 
assigned, the process did not return an error, and customers were not aware of the discrepancy.

Sample Code for createUser API

This section contains example code for the following scenarios:

https://docs.revenera.com/fno2025r2_onprem/producer/Content/helplibrary/opsActivateLicTransferEntitlementsWizard.htm
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• SOAP request with an invalid country code

• SOAP response for a request with an invalid country code

• SOAP request with a valid country code

• SOAP response for a request with a valid country code

SOAP request with an invalid country code

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v6.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:createUserRequest>
<!--1 or more repetitions:-->
<urn:user>

<urn:firstName>Dev008</urn:firstName>
<urn:lastName>New008</urn:lastName>
<urn:displayName>Dev008 New008</urn:displayName>
<urn:emailAddress>testtrial0015@revenera.com</urn:emailAddress>
<urn:street>Pehani</urn:street>
<urn:city>Gaya</urn:city>
<urn:state>NA</urn:state>
<urn:zipcode>54879</urn:zipcode>
<urn:country>Ind</urn:country>
<urn:canLogin>1</urn:canLogin>
<urn:acctRolesList>

<urn:acctRoles>
<urn:account>

<urn:primaryKeys>
<urn:id>123</urn:id>

</urn:primaryKeys>
</urn:account>
<urn:roles>

<urn:role>
<urn:primaryKeys>

<urn:name>Portal User Role</urn:name>
</urn:primaryKeys>

</urn:role>
</urn:roles>

</urn:acctRoles>
</urn:acctRolesList>

</urn:user>
<urn:opType>CREATE_OR_UPDATE</urn:opType>

</urn:createUserRequest>
</soapenv:Body>

</soapenv:Envelope>

SOAP response for a request with an invalid country code

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">

<soapenv:Body>
<createUserResponse xmlns="urn:v6.webservices.operations.flexnet.com">

<statusInfo>
<status>FAILURE</status>
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<reason>All input data in the request failed. Please check the specific reasons in 
returned data.</reason>

</statusInfo>
<failedData>

<failedUser>
<user>

<firstName>Dev0091</firstName>
<lastName>New0091</lastName>
<displayName>Dev0091 New0091</displayName>
<emailAddress>testtrial0091@revenera.com</emailAddress>
<street>Pehani</street>
<city>Gaya</city>
<state>NA</state>
<zipcode>54879</zipcode>
<country>Ind</country>
<canLogin>true</canLogin>
<acctRolesList>

<acctRoles>
<account>

<primaryKeys>
<id>123</id>

</primaryKeys>
</account>
<roles>

<role>
<primaryKeys>

<name>Portal User Role</name>
</primaryKeys>

</role>
</roles>

</acctRoles>
</acctRolesList>

</user>
<reason>9999: [Incident# 1863-943] Please provide correct format of 

country</reason>
</failedUser>

</failedData>
</createUserResponse>

</soapenv:Body>
</soapenv:Envelope>

SOAP request with a valid country code

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:urn="urn:v6.webservices.operations.flexnet.com">

<soapenv:Header/>
<soapenv:Body>

<urn:createUserRequest>
<!--1 or more repetitions:-->
<urn:user>

<urn:firstName>Dev0091</urn:firstName>
<urn:lastName>New0091</urn:lastName>
<urn:displayName>Dev0091 New0091</urn:displayName>
<urn:emailAddress>testtrial0091@revenera.com</urn:emailAddress>
<urn:street>Pehani</urn:street>
<urn:city>Gaya</urn:city>
<urn:state>NA</urn:state>
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<urn:zipcode>54879</urn:zipcode>
<urn:country>IN</urn:country>
<urn:canLogin>1</urn:canLogin>
<urn:acctRolesList>

<urn:acctRoles>
<urn:account>

<urn:primaryKeys>
<urn:id>123</urn:id>

</urn:primaryKeys>
</urn:account>
<urn:roles>

<urn:role>
<urn:primaryKeys>

<urn:name>Portal User Role</urn:name>
</urn:primaryKeys>

</urn:role>
</urn:roles>

</urn:acctRoles>
</urn:acctRolesList>

</urn:user>
<urn:opType>CREATE_OR_UPDATE</urn:opType>

</urn:createUserRequest>
</soapenv:Body>

</soapenv:Envelope>

SOAP response for a request with a valid country code

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">

<soapenv:Body>
<createUserResponse xmlns="urn:v6.webservices.operations.flexnet.com">

<statusInfo>
<status>SUCCESS</status>

</statusInfo>
<responseData>

<user>
<uniqueId>HID-75</uniqueId>
<userName>testtrial0091@revenera.com</userName>
<primaryKeys>

<firstName>Dev0091</firstName>
<lastName>New0091</lastName>
<emailAddress>testtrial0091@revenera.com</emailAddress>

</primaryKeys>
</user>

</responseData>
</createUserResponse>

</soapenv:Body>
</soapenv:Envelope>

updateProduct API Call No Longer Fails to Update Product Fields 
(ProductPackagingService)
(Cases 03043898, 03047906, 03048567, 03050705; SWM-27193)
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In the 2025 R1 release, the updateProduct API of the ProductPackagingService web service (all 
versions) failed to update product fields such as description, part number, and product line. The API 
returned the following reason for the failure: “All input data in the request failed. Please check the 
specific reasons in returned data.”

This issue has been resolved in the 2025 R2 release. The API now correctly updates all relevant 
product fields as expected.

User Experience Issues Resolved
The following issues related to user experience were addressed.

• Resolved Page Rendering Issue

• Localized Error Messages for Japanese Locale in End-User Portal

• Error Messages in End-User Portal’s “Forgot Password” Workflow Now Correctly Localized

• Multilingual Input in Email Templates

• Country Name “Türkiye” No Longer Contains Invalid Characters

• Performance Improvements of Bulk Upgrade Operations

• Bulk Upgrade Jobs with Auto-Fulfill No Longer Failing

• Password Reset Now Working As Expected

• “View Server” or “Device” Page in End-User Portal Now Displaying Custom Logo

• Analytics Menu and Configure Single Sign-On Page Now Accessible from Electronic Software 
Download Module Pages

Resolved Page Rendering Issue 
(SWM-28539)

Previously, when strict Content Security Policies were enforced, some Producer Portal pages and 
functionality did not load correctly. 

This issue has been resolved. The application now properly handles Content Security Policy 
requirements, ensuring that all pages and features function normally while maintaining enhanced 
security standards for the FlexNet Operations Producer Portal.

Localized Error Messages for Japanese Locale in End-User Portal
(SWM-30267)

Previously, when users selected the “Japanese” locale from the login page dropdown in the End-User 
Portal, error messages displayed during the Forgot Password workflow were shown in English instead 
of Japanese. This occurred in the following cases:

• When the user provided a wrong answer to the secret question.

• When the user clicked the Submit button without entering a user ID.
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This issue has been fixed, and error messages now display in Japanese, as shown in the following 
screenshots:

• Incorrect secret question answer

• No user ID entered

Error Messages in End-User Portal’s “Forgot Password” Workflow Now 
Correctly Localized
(SWM-26451)

Previously, error messages displayed during the End-User Portal's "Forgot Password" workflow were 
not correctly localized. Even when users selected a non-English language from the login page 
dropdown, error messages continued to appear in English.
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The screenshot below illustrates the issue, showing an English error message displayed despite 
“German” being selected as locale:

Unlocalized error messages were displayed in the following scenarios:

• Entering an incorrect answer to the secret question.

• Leaving the User ID field blank.

• Providing an invalid user ID.

In the 2025 R2 release, the login session now correctly applies the user’s selected locale. All error 
messages within the "Forgot Password" flow are properly localized according to the chosen language 
on the login page.

Note • The following related known issue remains that are being tracked separately: SWM-26453: 
Secret Question on Forgot Password Page Not Localized..

Multilingual Input in Email Templates
(Case 03031323, SWM-26966)

In previous releases, email templates did not support multilingual input—such as Japanese, Chinese, 
or Korean—in the Html Content and Text Content fields. As a result, templates containing these 
characters were saved with corrupted content, typically displayed as '?????'.
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Figure 39: Example of Chinese characters not rendered correctly.

The 2025 R2 release introduces full support for multilingual character encoding in both fields during 
template creation. Email content will now render correctly in the user's preferred language, based on 
their locale settings.

Country Name “Türkiye” No Longer Contains Invalid Characters
(Cases 03039999, 03048568; SWM-27007)

Previously, the country name “Türkiye” was not displayed correctly and appeared as “TÃ¼rkiye”. This 
occurred in the following cases: 

• When creating a user or account in the Producer Portal

• When creating a user or a sub-account in the End-User Portal
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Figure 40: Screenshot showing the Create A User page in the Producer Portal, where the country 
name “Türkiye” is now displayed correctly.

Performance Improvements of Bulk Upgrade Operations
(Case 03048145, SWM-27660)

In earlier releases, bulk upgrade operations processing large data volumes could encounter failures 
and timeouts due to a missing filter.

In the 2025 R2 release, the missing filter has been added, significantly improving the reliability and 
performance of bulk operations.

Bulk Upgrade Jobs with Auto-Fulfill No Longer Failing
(Case 03036671, SWM-26914)

Bulk operation jobs with auto-fulfill for FlexNet Embedded are no longer failing.

Password Reset Now Working As Expected
(Case 03238562, SWM-27609)

Previously in certain environments of the Producer Portal and End-User Portal, the password reset 
feature did not function correctly. Specifically, this issue occurred intermittently in the Production 
NAM5 environment.

On the Create A User page, clicking the Reset password button would send an email with a temporary 
password. However, the password could not be used to log in to the Producer Portal or End-User 
Portal. 

This issue has now been resolved, and the password reset process is working as intended.
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“View Server” or “Device” Page in End-User Portal Now Displaying Custom 
Logo
(Case 03030863, SWM-26718)

In the End-User Portal, the Device or View Server page (available from the Devices menu) no longer 
incorrectly displays the Revenera logo and “FlexNet Operations” product name, instead of a custom 
logo (if a custom logo has been specified).  

Figure 41: Example of the View Server page in the End-User Portal with a custom logo.

Note • Producers can upload an image file to serve as custom logo in the End-User Portal using the 
Upload Company Logo configuration option (under System > Configure > End-User Portal Setup > 
Custom Branding). 

Analytics Menu and Configure Single Sign-On Page Now Accessible from 
Electronic Software Download Module Pages 
(SWM-23190)

Previously in the Producer Portal, when navigating to any page that is part of the Electronic Software 
Download module, the Analytics menu and the Configure Single Sign-On option (under the Administer 
menu) were not displayed and therefore could not be accessed.

The Electronic Software Download module includes the areas Download Packages, Files, Agreements 
and Producers under the Products menu. 

This issue has been resolved. The Analytics menu and the Configure Single Sign-On option now appear 
consistently, regardless of the navigation path taken. 
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Known Issues
The following describes known issues in the current FlexNet Operations release.

SWM-33666: Changing Activation ID State After Activation Is Allowed
In FlexNet Operations 2025 R2, it is possible to change an Activation ID state from Deployed to Draft 
even after the license has already been fulfilled (activated). Changing the activation state after 
activation should not be allowed, and this behavior differs from earlier releases, where state changes 
were correctly restricted once activation had occurred.

This issue can lead to unintended state changes and inconsistencies in license management.

SWM-30789: File Status Incorrectly Updated When Akamai Deletion Fails
When a file is deleted from FlexNet Operations, the system attempts to remove the corresponding file 
from Akamai storage. However, if the Akamai deletion request fails, FlexNet Operations currently 
updates the file status to “Deleted” even though the file still exists in Akamai. This results in an 
inconsistent system state, where the application indicates the file is deleted while it remains available 
in storage.

The following screenshot shows information for a file that is wrongly shown as “Deleted”.
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SWM-29531: Latest Changes to Line Item Custom Attributes Not Reflected 
in Transaction History
When updating a custom attribute for a line item, the transaction history does not reflect the latest 
changes. 

The following example illustrates the issue: 

Consider the OrderLine attribute for a line item was set to Pro Marketing Suite. It is then changed 
from Pro Marketing Suite to Advanced AI Content Generator in the Configure Line Item dialog, as 
shown below:

The change should be reflected in the Transaction Details page. However, the Transaction Details 
page still shows the previous value, Pro Marketing Suite, as shown in this screenshot:

As a workaround, re-save the line item for the latest update to be published.
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SWM-30699: Obsoleting Devices or Servers Across Accounts
In the End-User Portal, users with the Obsolete Devices/Servers permission can currently mark 
devices or servers as obsolete even if those assets belong to a different account. This behavior is 
unintended and violates account-level restrictions. Revenera plans to resolve this in the January 2026 
release.

SWM-26453: Secret Question on Forgot Password Page Not Localized
The secret question displayed on the Forgot Password page in the End-User Portal is currently not 
localized.

Figure 42: The secret question is not displayed in the language selected on the End-User Portal’s 
Login page.

The system retrieves and displays the security question in the original language it was configured and 
stored during the user's first login. This behavior persists regardless of the user's selected language 
preference in subsequent sessions.

SWM-24928: Email Addresses for “File Created User Email” Missing in 
Software Delivery Download History Report  
In the Software Delivery Download History report (available from the Analytics menu), the File Details 
table is not displaying email addresses in the File Created User Email column due to an issue with the 
field size. As a workaround, the File Created User Email column is populated with the same email 
addresses as those displayed in the File Uploaded User Email column, because these email addresses 
typically are identical.  

SWM-24042: Input Sanitization Disabled
(Case 02889178) 

The FlexNet Operations 2024.12 release introduced limitations to the characters allowed in certain 
Producer Portal fields (see Security Issues Resolved in 2024.12). The following special characters 
were no longer allowed in a number of input fields to protect against injection attacks: 

[ : < > { } @ ; = \ , ! / | ? " # $ % ~ ^ ` ' ]

This functionality has now been disabled to allow further impact assessment. This means that the 
character restrictions placed on fields listed in Security Issues Resolved in 2024.12 are no longer in 
force.

https://docs.revenera.com/fno2024/rn/Content/helplibrary/Security_Issues_Resolved_in_2024_12.htm
https://docs.revenera.com/fno2024/rn/Content/helplibrary/Security_Issues_Resolved_in_2024_12.htm
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SWM-23586: Hanging Bulk Operation Jobs Not Showing “Failed” Status
A fix made in the 2024.11 release (see description Import/Export Jobs Terminated Upon Job Server 
Restart) has been reverted for bulk operations. The fix remains in place for import/export jobs.

This means that any bulk operation jobs that hang when the job server is restarted are not terminated 
and are not automatically retriggered. 

SWM-19547: Download Search Page in End-User Portal Not Filtering Expired 
Accounts
In the End-User Portal, on the Download Search page (available from Downloads > Search Downloads), 
the Choose Account dropdown list does not filter out expired accounts. Instead, it erroneously displays 
expired and non-expired accounts. 

Note • The Choose Account dropdown list is only displayed if the user belongs to more than one 
account that is entitled to downloads.

SWM-15171: Auto-Fulfill Failing During Large Bulk Upgrade Jobs
Auto-fulfill might fail in bulk upgrade jobs that contain more than 2200 line items.

SSRE-20257: Upload of Large File Images Failing 
The upload of file images that exceed 1 GB using HTTP upload fails. For large file images, Revenera 
recommends using FTP upload.

SWM-19052: Feature Count Aggregation Not Working As Expected
If a feature’s aggregation type is changed, the relevant instance of the Cloud Licensing Service might 
not update the aggregated feature counts according to the new aggregation type. 

However, if the entitlement for the product that contains the features is mapped to a new Cloud 
Licensing Service instance, the feature counts are aggregated correctly as per the new aggregation 
type. 

FNO-69836: Variables in Vendor String Causing License Activation Issues
License activation fails for product upgrades or normal license activation when the product to be 
upgraded or activated is associated with a feature that has a vendor string which contains substitution 
variables that are enclosed in double quotes (for example, 
"activationId":"{EntitlementLineItem.activationId}").

FNO-69338: Navigation in Package Products Pages Skipping Review 
Features Page
When the user navigates through the Package Products pages (under Products > Features) using the 
Next button at the bottom of each page, the Review Features and Review Feature Bundles pages are 
erroneously skipped. 

https://docs.revenera.com/fno2024/rn/Content/helplibrary/Export_and_Import_Issues_Resolved_in_2024_11.htm
https://docs.revenera.com/fno2024/rn/Content/helplibrary/Export_and_Import_Issues_Resolved_in_2024_11.htm


FlexNet Operations 2025 R2 On-Premises ALM Release Notes  (April 2026)  93

As a workaround, users who want to review the features and feature bundles that they just added can 
click the Review Features and Review Feature Bundles links, respectively, in the Packaging Guide 
section at the bottom of the page to access the Review Features page. 

SWM-15870: Mismatch Between User Name and Email Address Causing 
Issues with ESD (UserOrgHierarchyService)
When creating a user via the UserOrgHierarchyService web service (the predecessor of the User 
Account Hierarchy Service web service), it is possible to have different values for user name and email 
address. However, users whose user name and email address do not match cannot access downloads 
in the End-User Portal. 

Producers who use the UserOrgHierarchyService should use the methods from the User Account 
Hierarchy Service web service to avoid a mismatch between the user name and email address. 

Note • The following changes have recently been made to the User Account Hierarchy Service web 
service:

• From the 2023.07 release onwards, it is not possible to create users with a mismatched user 
name and email address. See “createUser Operation in User Account Hierarchy Service Web 
Service No Longer Allows Mismatch Between User Name and Email Address” in the FlexNet 
Operations 2023 Release Notes.

• From the 2023.10 release onwards, users cannot update their email address to be different from 
their user name. See “updateUser Operation in User Account Hierarchy Service Web Service No 
Longer Allows Mismatch Between User Name and Email Address” in the FlexNet Operations 2023 
Release Notes.

FNO-69182: Incorrect Email Format Accepted When Creating User Via 
Import Template 
It is possible to create or update a user with an invalid email address format by importing user 
information using the Account and User import template (downloadable from Administer > Import 
Data Objects > Data Import Templates in the Producer Portal). Email addresses of the format abcd@ef 
(that is, an email address consisting of a recipient name, @ symbol and domain name but without top-
level domain) are erroneously accepted. 

FNO-68962: Invalid Characters in Device ID Causing Issues 
When the FlexNet Embedded toolkit creates a device ID that contains an invalid character, an error 
occurs.

The following control characters are not allowed in device names or the device ID:

^B ^D ^E ^G ^N ^O ^P ^Q ^R ^S ^T ^U ^W ^X ^Y ^[ ^\ ^] ^F ^C ^^ ^A ^V ^_ 

https://docs.revenera.com/fno2023/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2023/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2023/rn/Content/helplibrary/fno_rn.htm
https://docs.revenera.com/fno2023/rn/Content/helplibrary/fno_rn.htm


FlexNet Operations 2025 R2 On-Premises ALM Release Notes  (April 2026)  94

SWM-10701: Search Functionality in End-User Portal Erroneously Displays 
Download Link 
In the End-User Portal, users who should be denied access to a file based on their geographical 
location are able to display the download link for a restricted file when searching for the file name 
(using the Search function with the Files option on the Download Search page). However, users are not 
able to download the restricted file. 

FNO-66018: Errors in UI Updated for Download Package Selection Across 
Multiple Pages
In 2021.09, the Download Packages window was updated to allow package selection across multiple 
pages. The following errors currently exist for the updated UI.

• Incorrect error message for EULA license on Review & Resolve page

• Search string not properly clearing

• No option to return to full (unfiltered) Download Package list when “failed validation” message 
displays

• Failed validation error displayed for search results

• Pagination control fields not showing correct information

• Inappropriate message displayed for already downloaded packages

Incorrect error message for EULA license on Review & Resolve page

When you attempt to download packages that fail validation, the following message is displayed: 
“Some of the selected packages failed validation. You need to review and resolve the validation 
errors.” Then, on the Failed Packages window that is displayed if you click the “review and resolve” 
link in the message, the error for an unaccepted EULA incorrectly shows the following:

 “EULA has not been accepted. To accept EULA, click on the Download package ID.” 

Instead of “click on the Download Package ID”, the message should instruct the user to “...click ‘I 
Agree’”. 

Search string not properly clearing 

After you filter the package list on the Download Packages window, the message “Results for 
Download package name: <name>” is appropriately displayed. However, if you then click the Clear link 
at the end of message, the search string used to filter the package list remains, the list remains 
filtered (even if you move to the next page), and the “Results for the Download package name...” 
message is still displayed. You must manually delete the search string and click Search to clear the 
filter.

No option to return to full (unfiltered) Download Package list when “failed validation” 
message displays

If the “failed validation” message is displayed after you attempt to download packages from a filtered 
list on the Download Packages window, no mechanism exists to clear the filter to display all packages. 
You must manually delete the search field contents and click Search.



FlexNet Operations 2025 R2 On-Premises ALM Release Notes  (April 2026)  95

Failed validation error displayed for search results

After searching for and attempting to download a package containing an unaccepted EULA, the 
expected message “Some of the selected packages failed validation...” is displayed on the Download 
Packages window. However, if you then search for a package that does not contain an EULA (but do 
not attempt to download the package), you received the “failed validation” message instead of the 
correct message describing the filter results: “Results for Download package name: <name>”.

Pagination control fields not showing correct information

The pagination control fields on the Download Packages window are not displaying the correct totals 
for a filtered list of packages.

Inappropriate message displayed for already downloaded packages

When you select an entitlement line item whose packages have already been downloaded, the 
Download Packages window is displayed with incorrect message “Files sent for download. Please 
monitor the download manager pop up”. The message should be removed altogether or displayed only 
as package files are being sent to the Download Manager (before the actual Download Manager 
window is displayed).

SWM-7952: Not All Applicable Download Links Available on “List 
Downloads” Page in End-User Portal
When end users are logged in with an activation ID for an entitlement line item that is associated with 
multiple products, the Downloads page (accessed from Downloads > List Downloads) in the End-User 
Portal does not always show links to all applicable product downloads.

SWM-7786: SHA2 Checksum Value of Previous File Shown
If a user has provided a file’s expected SHA2 checksum value for an upload and the file image is 
subsequently deleted, the Upload File page, when opened again, might show the SHA2 checksum 
value of the previously loaded file image.

FNO-65909: Download Files Not Visible For Self-registered And Trial Users
Download files might not be visible in the End-User Portal for self-registered users and those users 
registered through the “Try Before You Buy” registration.

FNO-61266: Translation Issues with Localization
Per a previous enhancement in 2020 R3 to add more language support for End-User Portal 
localization, certain strings—such as alerts and validation messages—are not being translated 
properly when localization is in effect. These issues will be addressed in an upcoming release.

Special Notes
This section contains special information pertaining to FlexNet Operations.

• Plug-in Upgrade Needed for High-Speed File Uploads

• Handling UI Conflicts When Using a Custom CSS for the End-User Portal
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Plug-in Upgrade Needed for High-Speed File Uploads
If you intend to use the high-speed upload option to upload files, upgrade the Aspera plug-in to Aspera 
Connect 3.10.0 or later. 

Handling UI Conflicts When Using a Custom CSS for the End-User Portal
When you use your own CSS to customize the look of the End-User Portal, sometimes your custom CSS 
code conflicts with existing Revenera CSS code that is used to define certain buttons, pages, and other 
UI elements. When conflicts occur, handle each case individually, determining the basis of the conflict 
and adjusting the custom CSS as needed. If you require assistance, contact Revenera Technical 
Support (see Revenera Resources).

SOAP API Change Log
The following sections describe the changes that have been made to the FlexNet Operations SOAP API 
in the FlexNet Operations 2025 R2 release:

• Ability to Exclude Expired Activations (EntitlementOrderService)

• Entitlement Order Service Now Accepts Multiple Account Names

• New API Commands to Report Custom Attributes for Entitlements and Line Items

• Ability to Retrieve Devices Not Associated to Any Account (ManageDeviceService)

• Optional vendorAuthString parameter in getFeaturesQueryRequest API (ProductPackagingService)

• Efficient Device Retrieval by Order Parameters (ManageDeviceService)

Ability to Exclude Expired Activations 
(EntitlementOrderService)

In the EntitlementOrderService, a new optional input query parameter named excludeExpired has 
been introduced for the getEntitlementLineItemPropertiesQuery to enable you to exclude expired 
activations from search results. 

• True—When excludeExpired is set to true, all expired activations—those with expiration dates 
earlier than the current local date—will be excluded from the results. 

• False—If excludeExpired is omitted or set to false, all activations, including expired ones, will be 
included.

To implement this change, the EntitlementOrderService’s associated entitlementLineItemTypes.xsd 
file has been updated.

Note • This enhancement was tracked in SWM-27421.
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entitlementLineItemTypes.xsd

In the entitlementLineItemTypes.xsd file, the following changes were made. Additions are 
highlighted.

Entitlement Order Service Now Accepts Multiple 
Account Names

In the EntitlementOrderService SOAP web service (versions 8 and 9), a new accountUnitNameList 
parameter was added that accepts multiple account names.

In certain EntitlementOrderService operations, using the accountUnitName query parameter with the 
EQUALS operator could incorrectly trigger an error if the specified account name contained a space.

To address this issue, versions 8 and 9 of EntitlementOrderService use the newly introduced 
accountUnitNameList parameter, which accepts multiple account names. Customers can provide 
multiple account unit names using repeated <urn:value>?</urn:value> elements.

The following operations were impacted:

• getActivatableItemCount

• getActivatableItemsQuery

• getEntitlementLineItemPropertiesQuery

To implement this change, the following file was modified:

• entitlementLineItemTypes.xsd

Note • This enhancement was tracked in SWM-29389.

# Change

1 <xs:complexType name="searchActivatableItemDataType">
<xs:sequence>       

<xs:element name="parentBulkEntitlementId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="entitlementId" type="tns:SimpleQueryType" minOccurs="0"/>

<xs:element name="activationIds" type="tns:activationIdList" minOccurs="0" />
<xs:element name="productName" type="tns:SimpleQueryType" minOccurs="0"/>
.
.
.
<xs:element name="activatableItemOwnersSearch" type="tns:ActivatableItemOwnersType" minOccurs="0"/>
<xs:element name="excludeExpired" type="xs:boolean" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
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entitlementLineItemTypes.xsd

The following changes/additions were made to the entitlementLineItemTypes.xsd file. Changes and 
additions are highlighted.

New API Commands to Report Custom Attributes for 
Entitlements and Line Items

The 2025 R2 release introduced a number of enhancements that enables users to search using 
specific custom entitlement attributes when using the SOAP API getActivatableItemsQuery command 
in the EntitlementOrderService wsdl. The new API command returns all entitlements and line items 
with their custom attributes. Previously, the request only supported searching using custom license 
attributes. 

To implement these new actions, the EntitlementOrderService.wsdl file and its associated .xsd files 
have been updated from v8 to v9:

/schema-public/v9/EntitlementOrderService.wsdl
/schema-public/v9/bulkEntitlementTypes.xsd
/schema-public/v9/commonEntitlementTypes.xsd
/schema-public/v9/commonIdentifierTypes.xsd
/schema-public/v9/commonTypes.xsd
/schema-public/v9/entitlementLifeCycleTypes.xsd
/schema-public/v9/entitlementLineItemTypes.xsd
/schema-public/v9/entitlementOrderTypes.xsd
/schema-public/v9/simpleEntitlementTypes.xsd

In additional to updating the version, additions were made to the following files:

• EntitlementOrderService.wsdl

• entitlementLineItemTypes.xsd

• entitlementOrderTypes.xsd

• entitlementAttributeTypes.xsd, a new .xsd file that was added in this release

Note • This enhancement was tracked in SWM-19774 and SWM-20135 (see also New API Commands 
to Report Custom Attributes for Entitlements and Line Items (EntitlementOrderService, Version 9) and 

# Change

1 <xs:complexType name="searchActivatableItemDataType">
<xs:sequence>       

<xs:element name="parentBulkEntitlementId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="entitlementId" type="tns:SimpleQueryType" minOccurs="0"/>

<xs:element name="activationIds" type="tns:activationIdList" minOccurs="0" />
. . .
<xs:element name="allowPortalLogin" type="xs:boolean" minOccurs="0"/>
<xs:element name="accountUnitName" type="tns:PartnerTierQueryType" minOccurs="0"/>
<xs:element name="accountUnitNameList" type="tns:AccountNamesQueryType"  minOccurs="0"/>
<xs:element name="currentOwnerName" type="tns:SimpleQueryType"  minOccurs="0"/>



FlexNet Operations 2025 R2 On-Premises ALM Release Notes  (April 2026)  99

Entitlement Order Service Now Returning Activatable Item Owner Details (EntitlementOrderService, 
Version 9), respectively).

EntitlementOrderService.wsdl

In addition to updating the version number from 8 to 9 in multiple locations in the 
ManageDeviceService.wsdl file, the following additional changes were made. Additions are 
highlighted.

# Change

1 <message name="unlinkMaintenanceLineItemResponse">
<part name="msgparameters" element="tns:unlinkMaintenanceLineItemResponse"/>

</message>
<message name="searchEntitlementAttributeRequest">

<part name="msgparameters" element="tns:searchEntitlementAttributeRequest"/>
</message>
<message name="searchEntitlementAttributeResponse">

<part name="msgparameters" element="tns:searchEntitlementAttributeResponse"/>
</message>
<message name="getEntitlementAttributeCountRequest">

<part name="msgparameters" element="tns:getEntitlementAttributeCountRequest"/>
</message>
<message name="getEntitlementAttributeCountResponse">

<part name="msgparameters" element="tns:getEntitlementAttributeCountResponse"/>
</message>

2 <operation name="unlinkMaintenanceLineItem">
<input message="tns:unlinkMaintenanceLineItemRequest"/>
<output message="tns:unlinkMaintenanceLineItemResponse"/>

</operation>
<operation name="getEntitlementsAttributeQuery">

<input message="tns:searchEntitlementAttributeRequest"/>
<output message="tns:searchEntitlementAttributeResponse"/>

</operation>
<operation name="getEntitlementAttributeCount">

<input message="tns:getEntitlementAttributeCountRequest"/>
<output message="tns:getEntitlementAttributeCountResponse"/>

</operation>
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entitlementLineItemTypes.xsd

In addition to updating the version number from 8 to 9 in the entitlementLineItemTypes.xsd file, the 
following additional changes were made. Additions are highlighted.

3 <operation name="getEntitlementsQuery">
<soap:operation style="document"/>
<input>

<soap:body use="literal" />
</input>
<output>

<soap:body use="literal" />
</output>

</operation>
<operation name="getEntitlementsAttributeQuery">

<soap:operation style="document"/>
<input>

<soap:body use="literal" />
</input>
<output>

<soap:body use="literal" />
</output>

</operation>

4 <operation name="getEntitlementCount">
<soap:operation style="document"/>
<input>

<soap:body use="literal" />
</input>
<output>

<soap:body use="literal" />
</output>

</operation>
<operation name="getEntitlementAttributeCount">

<soap:operation style="document"/>
<input>

<soap:body use="literal" />
</input>
<output>

<soap:body use="literal" />
</output>

</operation>

# Change

1 <xs:element name="sortBys" type="tns:activatableItemsSortBys" minOccurs="0"/>
<xs:element name="isEmbeddedLicenseModel" type="xs:boolean" minOccurs="0"/>
<xs:element name="lineItemState" type="tns:StateQueryType"  minOccurs="0"/>
<xs:element name="soldToDisplayName" type="tns:SimpleQueryType"  minOccurs="0"/>
<xs:element name="productLine" type="tns:SimpleQueryType"  minOccurs="0"/>
<xs:element name="expiresIn" type="tns:DurationType"  minOccurs="0"/>
<xs:element name="activatableItemOwnersSearch" type="tns:ActivatableItemOwnersType"  minOccurs="0"/>

# Change
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entitlementOrderTypes.xsd

In addition to updating the version number from 8 to 9 in the entitlementOrderItemTypes.xsd file, the 
following additional changes were made. Additions are highlighted.

entitlementAttributeTypes.xsd

The entitlementAttributeTypes.xsd file has been added in this release. It contains the following 
Elements:

<xs:complexType name="searchEntitlementAttributeDataType">
<xs:sequence>

<xs:element name="entitlementId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="activationIds" type="tns:activationIdList" minOccurs="0" />
<xs:element name="entDescription" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="productName" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="productVersion" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="productType" type="tns:ProductType" minOccurs="0"/>
<xs:element name="partNumber" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="isBulk" type="xs:boolean" minOccurs="0"/>
<xs:element name="soldTo" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="shipToEmail" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="contactEmail" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="shipToAddress" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="emailTemplateVariation" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="startDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="isPermanent" type="xs:boolean" minOccurs="0"/>
<xs:element name="expirationDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="isAutoRenewal" type="xs:boolean" minOccurs="0"/>
<xs:element name="renewalInterval" type="tns:DurationType" minOccurs="0"/>

2 <xs:element name="fetchCreatedBy" type="xs:boolean" minOccurs="0"/> 
<xs:element name="fetchLastModifiedBy" type="xs:boolean" minOccurs="0"/>
<xs:element name="activatableItemOwners" type="xs:boolean" minOccurs="0"/>

3 <xs:element name="transferredFromLineItem" type="xs:string" minOccurs="0"/>
<xs:element name="splitFromLineItem" type="xs:string" minOccurs="0"/>
<xs:element name="activatableItemOwners" type="tns:ActivatableItemOwnersType" minOccurs="0"/>

4 <xs:element name="unlinkMaintenanceLineItemRequest" type="tns:unlinkMaintenanceLineItemRequestType"/>
<xs:element name="unlinkMaintenanceLineItemResponse" type="tns:unlinkMaintenanceLineItemResponseType"/>

<xs:complexType name="ActivatableItemOwnersType">
<xs:sequence>

<xs:element name="activatableItemOwner" type="xs:string" minOccurs="0" maxOccurs="unbounded"/>
</xs:sequence>

</xs:complexType>

# Change

1 <xs:include schemaLocation="../../schema-public/v9/entitlementLifeCycleTypes.xsd"/>
<xs:include schemaLocation="../../schema-public/v9/entitlementAttributeTypes.xsd"/>

# Change
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<xs:element name="renewalExpirationDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="createdOn" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="versionDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="lastModifiedDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="description" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="state" type="tns:StateQueryType" minOccurs="0"/>
<xs:element name="licenseTechnology" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="createdUserId" type="tns:SimpleQueryType" minOccurs="0"/>
<xs:element name="accountUnitName" type="tns:PartnerTierQueryType"  minOccurs="0"/>
<xs:element name="currentOwnerName" type="tns:SimpleQueryType"  minOccurs="0"/>
<xs:element name="maintStartDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="maintIsPermanent" type="xs:boolean" minOccurs="0"/>
<xs:element name="maintExpirationDate" type="tns:DateQueryType" minOccurs="0"/>
<xs:element name="entitlementAttributes" type="tns:entCustomAttributesQueryListType" 

minOccurs="0"/>
</xs:sequence>

</xs:complexType>

<xs:complexType name="entitlementAttributeDataType">
<xs:choice>

<xs:element name="simpleEntitlement"   type="tns:simpleEntitlementDataType" minOccurs="0"/>
<xs:element name="bulkEntitlement"   type="tns:bulkEntitlementDataType" minOccurs="0" />

</xs:choice>
</xs:complexType>

<xs:complexType name="searchEntitlementAttributeRequestType">
<xs:sequence>

<xs:element name="entitlementAttributeSearchCriteria" 
type="tns:searchEntitlementAttributeDataType"/>

<xs:element name="batchSize" type="xs:integer"/>
<xs:element name="pageNumber" type="xs:integer" minOccurs="0"/>

</xs:sequence>
</xs:complexType>

<xs:complexType name="searchEntitlementAttributeResponseType">
<xs:sequence>

<xs:element name="statusInfo"   type="tns:StatusInfoType"/>
<xs:element name="entitlement"   type="tns:entitlementAttributeDataType" minOccurs="0" 

maxOccurs="unbounded"/>
</xs:sequence>

</xs:complexType>

<xs:complexType name="getEntitlementCountAttributeRequestType">
<xs:sequence>

<xs:element name="queryParams" type="tns:searchEntitlementAttributeDataType"/>
</xs:sequence>

</xs:complexType>

<xs:complexType name="getEntitlementCountAttributeResponseType">
<xs:sequence>

<xs:element name="statusInfo"   type="tns:StatusInfoType"/>
<xs:element name="count"   type="xs:integer" minOccurs="0"/>

</xs:sequence>
</xs:complexType>

<xs:element name="searchEntitlementAttributeRequest" type="tns:searchEntitlementAttributeRequestType"/>
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<xs:element name="searchEntitlementAttributeResponse" type="tns:searchEntitlementAttributeResponseType"/>
<xs:element name="getEntitlementAttributeCountRequest" 
type="tns:getEntitlementCountAttributeRequestType"/>
<xs:element name="getEntitlementAttributeCountResponse" 
type="tns:getEntitlementCountAttributeResponseType"/>

Ability to Retrieve Devices Not Associated to Any 
Account (ManageDeviceService)

In the ManageDeviceService SOAP web service (version 7), a new enum value IS_EMPTY has been 
added to the simpleSearchType to enable searching for devices/servers where soldToAcctId is blank 
(devices/servers that are not associated to any account).

Note • This enhancement was tracked in SWM-21765.

To implement this change, the following file was modified:

• manageDeviceTypes.xsd

manageDeviceTypes.xsd

The following change was made to the manageDeviceTypes.xsd file. Additions are highlighted.

Optional vendorAuthString parameter in 
getFeaturesQueryRequest API 
(ProductPackagingService)

The getFeaturesQueryRequest API in the ProductPackagingService web service (version 3) supports 
the new optional parameter vendorAuthString. Producers can use the new parameter to retrieve the 
vendor auth string alongside other feature properties and to query feature information.

Note • This enhancement was tracked in SWM-27118 (see also Optional vendorAuthString parameter 
in getFeaturesQueryRequest API (ProductPackagingService, Version 3)).

# Change

1 <xs:simpleType name="simpleSearchType">
<xs:restriction base="xs:NMTOKEN">

<xs:enumeration value="STARTS_WITH"/>
<xs:enumeration value="CONTAINS"/>
<xs:enumeration value="ENDS_WITH"/>
<xs:enumeration value="EQUALS"/>
<xs:enumeration value="IS_EMPTY"/>

</xs:restriction>
</xs:simpleType>    
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Modifications were made to the following file:

• featureTypes.xsd

featureTypes.xsd

The following changes were made to this file. Additions are highlighted.

# Change

1 <xs:complexType name="featureDataType">
<xs:sequence>

<xs:element name="featureName" type="xs:string"/>
<xs:element name="versionFormat" type="tns:VersionFormatType"/>
<xs:element name="version" type="xs:string" minOccurs="0"/>
<xs:element name="maxVersion" type="xs:string" minOccurs="0"/>
<xs:element name="description" type="xs:string" minOccurs="0"/>
<xs:element name="aggregationType" type="tns:AggregationType" minOccurs="0"/>
<xs:element name="vendorAuthString" type="xs:string" minOccurs="0"/>
<xs:element name="featureOverrideParams" type="tns:featureOverrideParamsType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>

2 <xs:complexType name="featureOverrideParamsType">
<xs:sequence>

<xs:element name="vendorString" type="xs:string" minOccurs="0"/>
<xs:element name="notice" type="xs:string" minOccurs="0"/>
<xs:element name="borrowable" type="xs:string" minOccurs="0"/>
<xs:element name="serialNumber" type="xs:string" minOccurs="0"/>
<xs:element name="dupGroup" type="tns:dupGroupDataType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>  

3 <xs:complexType name="featureQueryDataType">
<xs:sequence>

<xs:element name="uniqueId" type="xs:string"/>
<xs:element name="featureName" type="xs:string"/>
<xs:element name="versionFormat" type="tns:VersionFormatType"/>
<xs:element name="version" type="xs:string" minOccurs="0"/>
<xs:element name="description" type="xs:string" minOccurs="0"/>
<xs:element name="state" type="tns:StateType"/>
<xs:element name="vendorAuthString" type="xs:string" minOccurs="0"/>
<xs:element name="featureOverrideParams" type="tns:featureOverrideParamsType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>
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Efficient Device Retrieval by Order Parameters 
(ManageDeviceService)

The ManageDeviceService API now supports orderId (Factory Order Number) and orderLineNumber 
(Sales Order Number) as query parameters in getDevicesQuery and getDeviceCount.

This enhancement eliminates the need for multiple entitlement-based service calls, enabling:

• Direct device lookup using orderId or orderLineNumber.

• Faster performance for large orders with hundreds of line items

• Improved scalability for cloud-based LIT portal operations.

End users can now retrieve device details and counts quickly without delays caused by iterative calls.

To implement these new actions, the ManageDeviceService.wsdl file and its associated .xsd file have 
been updated from v7 to v8:

/schema-public/v8/ManageDeviceService.wsdl
/schema-public/v8/manageDeviceTypes.xsd

In additional to updating the version, additions were made to the following file:

• manageDeviceTypes.xsd

4 <xs:complexType name="updateFeatureDataType">
<xs:sequence>

<xs:element name="featureIdentifier" type="tns:featureIdentifierType" />
<xs:element name="featureName" type="xs:string" minOccurs="0"/>
<xs:element name="versionFormat" type="tns:VersionFormatType" minOccurs="0"/>
<xs:element name="version" type="xs:string" minOccurs="0"/>
<xs:element name="maxVersion" type="xs:string" minOccurs="0"/>
<xs:element name="description" type="xs:string" minOccurs="0"/>
<xs:element name="vendorAuthString" type="xs:string" minOccurs="0"/>
<xs:element name="aggregationType" type="tns:AggregationType" minOccurs="0"/>
<xs:element name="featureOverrideParams" type="tns:featureOverrideParamsType" minOccurs="0"/>

</xs:sequence>
</xs:complexType>

5 <xs:complexType name="featureQueryParametersType">
<xs:sequence>

<xs:element name="featureName" type="tns:SimpleQueryType" minOccurs="0" nillable="true"/>
<xs:element name="version" type="tns:SimpleQueryType" minOccurs="0" nillable="true"/>
<xs:element name="versionFormat" type="tns:VersionFormatQueryType" minOccurs="0" nillable="true"/>
<xs:element name="description" type="tns:SimpleQueryType" minOccurs="0" nillable="true"/>
<xs:element name="state" type="tns:StateQueryType" minOccurs="0" nillable="true"/>
<xs:element name="creationDate" type="tns:DateQueryType" minOccurs="0" nillable="true"/>
<xs:element name="lastModifiedDate" type="tns:DateQueryType" minOccurs="0" nillable="true"/>
<xs:element name="vendorAuthString" type="tns:SimpleQueryType" minOccurs="0" nillable="true"/>

</xs:sequence>
</xs:complexType>  

# Change
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Note • This enhancement was tracked in SWM-29382, see Device Retrieval by Order Parameters 
(ManageDeviceService, Version 8).

manageDeviceTypes.xsd

In addition to updating the version number from 7 to 8 in the manageDeviceTypes.xsd file, the 
following additional changes were made. Additions are highlighted.

# Change

1     <xs:complexType name="getDevicesParametersType">
        <xs:sequence>
            <xs:element minOccurs="0" name="alias" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="deviceId" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="deviceIdType" type="tns:DeviceIdTypeQueryType"/>
            <xs:element minOccurs="0" name="parentId" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="hostTypeName" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="soldTo" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="soldToAcctId" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="description" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="status" type="tns:DeviceStateQueryType"/>
            <xs:element minOccurs="0" name="addOnActivationId" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="addOnProductName" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="addOnProductVersion" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="featureName" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="isServer" type="xs:boolean"/>
            <xs:element minOccurs="0" name="deviceTypes" type="tns:deviceTypeList"/>
            <xs:element minOccurs="0" name="userString" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="siteName" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="orderId" type="tns:SimpleQueryType"/>
            <xs:element minOccurs="0" name="orderLineNumber" type="tns:SimpleQueryType"/>
        </xs:sequence>
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Legal Information
Copyright Notice
Copyright © 2026 Flexera Software

This publication contains proprietary and confidential information and creative works owned by 
Flexera Software and its licensors, if any. Any use, copying, publication, distribution, display, 
modification, or transmission of such publication in whole or in part in any form or by any means 
without the prior express written permission of Flexera Software is strictly prohibited. Except where 
expressly provided by Flexera Software in writing, possession of this publication shall not be construed 
to confer any license or rights under any Flexera Software intellectual property rights, whether by 
estoppel, implication, or otherwise.

All copies of the technology and related information, if allowed by Flexera Software, must display this 
notice of copyright and ownership in full.

FlexNet Operations incorporates software developed by others and redistributed according to license 
agreements. Copyright notices and licenses for these external libraries are provided in a 
supplementary document that accompanies this one.

Intellectual Property
For a list of trademarks and patents that are owned by Flexera Software, see 
https://www.revenera.com/legal/intellectual-property.html. All other brand and product names 
mentioned in Flexera Software products, product documentation, and marketing materials are the 
trademarks and registered trademarks of their respective owners.

Restricted Rights Legend
The Software is commercial computer software. If the user or licensee of the Software is an agency, 
department, or other entity of the United States Government, the use, duplication, reproduction, 
release, modification, disclosure, or transfer of the Software, or any related documentation of any kind, 
including technical data and manuals, is restricted by a license agreement or by the terms of this 
Agreement in accordance with Federal Acquisition Regulation 12.212 for civilian purposes and 
Defense Federal Acquisition Regulation Supplement 227.7202 for military purposes. The Software was 
developed fully at private expense. All other use is prohibited.

https://www.revenera.com/legal/intellectual-property.html
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